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About This Guide

This guide explains imaging concepts and provides information
about using the Imaging ActiveX controls to implement imaging
features in your applications.

In this Chapter

PUIPOSE . Xiv
PrereqUISIEES ....oooiiiiiiee e Xiv

Related INfOrmation ..........eeeeeeeeeee e Xiv
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Purpose

Prerequisites

The Developer’s Guide describes the features of eiStream Imaging
for Windows® and provides software developers and MIS
professionals with the information they need to produce and
support image-enabled applications.

This guide is a technical resource that supplements the on-line
help and documentation included with the Imaging for Windows
product.

To use this product, you should be familiar with the Microsoft®”
Windows environment. If you are using a printer, a scanner, or a
TWAIN-compliant device, you should also know how to connect
and operate it.

If you plan to access documents residing on WMS Imaging Server
(1.x) or a WMS Imaging and Workflow (WMS) server, you
should be familiar with navigating document databases in those
environments.

Related Information

Xiv

For instructions on how to use the Imaging ActiveX controls,
access the on-line help system for the controls from your
development environment.

For updated product information and general information about
Imaging for Windows, visit our Web site at:

www.eiStream.com

Proceed to WMS | Kofile or eiStream WMS. Under products,
select eiStream Imaging for Windows.


http://www.eiStream.com/sonora

About This Guide |

Support

Should you have questions regarding Imaging for Windows, or
problems with your system after installation, consult your customer
support representative.

For technical support, visit our Web site at:
www.eiStream.com

Proceed to WMS | Kofile or eiStream WMS. Under products,
select eiStream Imaging for Windows, and then click the Support
link.

The Support area includes technical bulletins, current
documentation, and other relevant information. To request a
patch, send an e-mail to Technical Support.

XV
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About Imaging

This chapter describes the Imaging for Windows® product and suggests
ways in which the product features can be used in business and personal
document imaging.

In This Chapter

Introducing Imaging for Windows ...........ccccooiiviiiiiiiiiiiiccice 2
What Imaging Lets YOU DO .....oioiiiiiiiiiiiiee e 5
What Imaging Lets Your Users DO ..........coooveiiiiiiiiieieieeee 13
What Is Document IMaging? ......cccoooviiiiiieiii e 14

Compiling and Distributing Your Image-Enabled Application........ 16
Use of LZW Compression

Documentation Conventions
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Introducing Imaging for Windows

This section describes the
Imaging for Windows
product.

Imaging for Windows is a multi-faceted product allowing users to
transform paper documents and faxes into electronic documents for
viewing, annotating, editing, converting, printing, and sharing.

Today, eiStream is offering the latest version of Imaging for Windows.
This product is an upgrade to the component included in various
Microsoft operating systems and an upgrade to Imaging for Windows
Professional Edition and Imaging for Windows Standard Edition. The
latest version supports multi-byte character sets and runs on multiple
Microsoft operating systems — Windows 2000, Windows XP, Windows
98, and Windows NT.

Imaging Components

The components of Imaging for Windows are described in this section.
Imaging Application

The Imaging application is the main component of Imaging for
Windows. It enables users to scan, view, annotate, manipulate, and store
faxes, paper documents, and electronic images.
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Imaging Preview

Imaging Preview is a lean version of the Imaging application. It lets users
view image files quickly and, if necessary, load them into the Imaging
application for editing.

Imaging Flow

Imaging Flow enables users to automatically capture, process, and output
image files. An intelligent and editable procedure — called a flow —
defines and controls the work Imaging Flow performs.
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Flow tools included within each flow perform specific functions. They
can:
* Capture images from:

— Scanners.

— MAPI-compliant in-boxes.

— Local and network folders.
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* Process images by:
— Converting them from one file type to another.
— Applying compression.
— Enhancing their appearance.
— Permitting their review.
— Converting them to text.
— Deleting specified pages.
— Entering information about an image document while the flow is
processing.
— Running a custom process.
*  Output images by:
— Posting them to Exchange folders.
— Saving them to local or network folders.
— Saving them to WMS Imaging or Imaging (1.x) servers
— Printing them.
— Sending them to others via e-mail.

— Running a custom process.

Development Tools and Methods

Imaging for Windows includes a rich set of development tools and
methods that let you — the software developer — add Imaging functions
to your applications.

To add Imaging functions, you must be using a development
environment that supports OLE, Automation, and ActiveX controls;
such as:

*  Microsoft Visual Basic

*  Microsoft Visual C++

*  Microsoft Office (Visual Basic for Applications)
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What Imaging Lets You Do

This section describes what
Imaging for Windows lets
developers do.

Imaging for Windows includes several development tools and methods
that let you add Imaging functions to your 32-bit applications. The
development tools and methods include:

* Command-line invocation
= OLE

* Automation

= ActiveX controls

The following sections describe them, help you determine which one to
use, and briefly describe the code samples contained on the media on
which your software was distributed.

Command-line Invocation

OLE

You can invoke the Imaging application using its command line. Because
the command line can accept a fully qualified image file name, you can
use standard Shell functions within your application to invoke the
Imaging application with an image on display.

‘Within your call to the Shell function, include the path and file name of
the Imaging application along with the path and file name of the image
file you want it to display. (Refer to the example on page 8.)

You can use standard OLE functions to embed and link image files in
your application and other applications, such as Microsoft Word, Excel,
Access, and SQL Server.

For example, you can use Visual Basic’s OLE Container control to easily
embed or link image files in your application.

Your application is the container, while the Imaging application is the
server. Users can edit and open embedded or linked image files, as
described in the following sections.

Embedded Image Files

When you embed an image file in your application, the application stores
the image data within it.

When end users edit an embedded image file, it becomes “in-place
activated,” causing your application to display a subset of the Imaging
application menus. The menus provide access to Imaging functions that
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Automation

let users edit the activated image file “in-place;” that is, within your
application.

When end users open an embedded image file, the Imaging application
appears with the embedded image displayed within it. Changes users
make to the image in the Imaging application also appear on the linked
image in your application. If desired, users can save a copy of the image
to another file by clicking SaveAs on the File menu.

Linked Image Files

‘When you link an image in your application, the image data remains
external to your application. Your application stores only a reference to
the image file.

When end users edit or open a linked image file, the Imaging
application appears with the image file displayed, which enables them to
perform the full range of Imaging functions on the displayed image file.

In-place activation is not available because the linked image file may also
be available to other containers (referential integrity).

As in the case of embedded image files, changes users make to the image
in the Imaging application also appear on the linked image in your
application.

You can use Automation to image-enable your application.

Automation is a more powerful way to image-enable your application. It
enables you to control the Imaging application programmatically from
your application and provide your users with the capabilities contained
within the Imaging application.

Note: You can also use Automation to control the Imaging application
from other Automation-capable applications, such as Microsoft
Word and Excel.

However, you cannot use Automation to control the Imaging
Preview and Imaging Flow applications.

The Imaging application implements Automation as a full object model,
similar to the Automation model of Microsoft Word and Excel.

The object hierarchy starts with the Application object, continues with
an ImageFile object and one or more Page objects, and then concludes
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ActiveX Controls

with a Page Range object. Each object has its own set of properties and
methods.

Note: Chapter 2 of this guide explains Imaging’s implementation of
Automation. Chapter 3 describes the properties and methods of
each object.

You can use ActiveX controls to image-enable your application.

Using ActiveX controls is another powerful way to include Imaging
functions within your application. Imaging for Windows provides the
following ActiveX controls:

Image Admin control — The Image Admin control manages
administrative functions, such as: creating, opening, saving, and printing
image files; appending, inserting, and deleting image pages; and entering
Summary property information.

Image Annotation Tool Button control — The Image Annotation
Tool Button control lets you create customized annotation tool bars for
use within your application. The control links with the Image Edit
control to provide annotation drawing and management functions to
your end users.

Image Edit control — The Image Edit control manages all image
display and annotation functions. Its huge array of properties, methods,
and events provide Imaging functions, such as: displaying, annotating,
and editing images; rotating, flipping, and zooming images; applying
compression to images; and copying, cutting, and pasting images to and

from the Clipboard.

Image OCR control — The Image OCR control manages the
recognition and recomposition of image files. It lets users convert images
into editable text documents. Output formats include Microsoft Word/
Rich Text Format (RTF), Corel® WordPerfect, Hypertext Markup
Language (HTML), and text.

Image Scan control — The Image Scan control manages the scanning
of documents using TWAIN-compliant image acquisition devices.
TWAIN (Technology Without An Interesting Name) is an industry-
standard interface between image-enabled applications and image
acquisition devices.
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Image Thumbnail control — The Image Thumbnail control displays
and manages thumbnail renditions of individual image pages.

Note: Chapters 4 and 5 of this guide explain how to get started with
the Imaging ActiveX controls and walk you through several
sample programs.

Which to Use: Command-line Interface, OLE, Automation, or

ActiveX Controls?

The following sections describe the major differences in using the
command-line interface, OLE, Automation, or ActiveX controls to
image-enable an application.

Command-line Interface

Command-line invocation is the most simple but least powertul way to
implement Imaging functions in your application.

You can invoke the Imaging application using standard Shell functions,
by including the executable file name of the Imaging application and the
fully qualified file name of a supported image file.

For example, if you are developing under Imaging, you can use the
following statement to invoke the Imaging application and display an
image file:

Shel | ("c:\ Program Fi | es\ | magi ng\ | magi ng. exe
c:\Quote.tif", 1)

Employing the command-line interface does not make the Imaging
application a full-fledged component of your application. The
command-line interface does not give you the opportunity to manipulate
the application or the image after it is displayed.

OLE

OLE lets you add a subset of Imaging functions to your application. It is
useful when you want to add Imaging functions with an absolute
minimum of coding.

Using a container control such as that provided by Visual Basic, you can
add image files as insertable objects within your application at design
time. Image files may be embedded or linked.

As an alternative, you can use the container control to create a
placeholder in your application for image files that will be added at run
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time. Set the appropriate properties or provide end users with drag-and-
drop capability so they can select image files for display at run time.

Users can edit embedded images within your application and linked
images within the Imaging application.

OLE does not make the Imaging application a full-fledged component of
your application. OLE does not give you the opportunity to manipulate
the application or the image after it is displayed.

Automation

Automation lets you add Imaging functions to your application by
making the Imaging application a full-fledged component of your
application.

Automation is useful when you want images to be displayed in a window
that is separate from your application and when you want to control the
Imaging application from your application.

Your application can control the state of the Imaging application as well
as manipulate the displayed image. But, unlike using the Imaging
ActiveX controls, your application cannot respond to events that occur
when users perform Imaging operations.

Depending on the degree of control you want to exert, automating the
Imaging application from your application can be accomplished with a
minimal or substantial amount of coding.

Example
Imaging Flow, a component of Imaging for Windows, demonstrates a

good example of Automation.

The Review flow tool invokes the Imaging application to permit users to
review image files as they are being processed by the current flow.

At flow design time, the author can set Review tool options that
manipulate the Imaging application as well as the image it displays. These
options include:

*  Whether to view image pages, thumbnails, or both.

* The size and position of the Imaging application window.

* The zoom setting to apply to images.

*  Whether to open image files as read only.

*  Whether to scale black-and-white images to gray.



| Chapter 1

Sample Code

10

ActiveX Controls

The Imaging ActiveX controls let you add Imaging functions to your
application by making the functions an integral part your application.

The controls are useful when you want to display images within a
window in your application and when you want to manipulate all
Imaging functions from within your application.

While the ActiveX controls add overhead to your application, they give
you the power to determine the range of Imaging functions to be
provided. And, unlike Automation, the ActiveX controls support
extender as well as intrinsic events, which enable your application to
respond to events that occur when users perform Imaging operations.

Depending on the Imaging functions you want to provide, image-
enabling your application with ActiveX controls can require more coding
when compared to Automation.

Example

The demonstration projects in Chapters 4 and 5 of this guide are
excellent examples of using the Imaging ActiveX controls to image-
enable applications.

Sample code that was designed to help you add Imaging functions to
your applications is included on the media on which your Imaging for
Windows software was distributed, and also on the eiStream Web site.

Before you can use the sample code, you need to:
* Set up Imaging for Windows on your development system, if
necessary.

*  Set up Microsoft Excel and be familiar with Visual Basic for
Applications (for the Automation demonstration project).

* Set up and be familiar with Visual Basic (for the ActiveX
demonstration projects and the ActiveX sample applications).

Note: When you set up Visual Basic 6.0 or greater, you must perform a
Typical installation. If you don't, the sample code may not
function correctly.
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The following sections briefly describe the sample code.

Automation Demonstration Project

The Automation demonstration project shows you how to use
Automation in Excel to:

* Invoke the Imaging application.

* Display an image.

* Select the view mode.

* Rotate the image.

* Obtain the number of pages in the image file.

Chapter 2 of this guide walks you through the Automation project.

ActiveX Demonstration Projects

The ActiveX demonstration projects are small Visual Basic applications
that show you how to:

* Display an image and apply fit-to options.

* Convert an image.

* Copy an image.

* Print an image.

* Scan images using a template.

* Reorganize an image file using thumbnails.

* Unload a multipage image file.

= Access an interact with Imaging 1.x and WMS Imaging servers.

Chapters 4 and 5 of this guide walk you through each demonstration
project.

ActiveX Sample Applications

The ActiveX sample applications are relatively large Visual Basic projects
that show you how the Imaging ActiveX controls may be used to create
comprehensive and useful image-enabled applications.

‘While walking you through each sample application is beyond the scope
of this guide, you should run each application and analyze its code to
determine whether you can use the code directly in your application or
as a guide to writing your own, related code.

11
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The code in each sample project is highly organized, heavily
commented, and written using Hungarian notation. The sample
applications show you how to:

* Create an application that is similar to the standard Imaging
application.

* Develop an application that prepares separator pages for scanning
several multipage documents in the Imaging Flow application.

*  Perform template scanning.

* Use the Image Thumbnail control to create folder-based contact
sheets.

* Print a selected portion of an image.
* Use General and Page properties to analyze image files in folders.

Appendix A describes each sample application in greater detail.
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What Imaging Lets Your Users Do

Imaging for Windows lets your users access and control paper-based

information directly on their PCs. With it, users can view, manipulate,

annotate, print, file, and share documents they used to manage as

cumbersome paper files.

The following types of business documents are ideal subjects for image
processing:

Business cards

Letters

Legal documents
Handwritten meeting notes
Memoranda

Newsclips

Technical drawings

The following types of personal documents are also ideal subjects for
image processing:

Childrens’ drawings
Hobby-related documents
Household bills

Legal documents

Letters from friends

Magazine and newspaper articles
Medical and insurance records
Receipts

Tax forms

Depending on how you design and code your application, you can

enable your users to:

Scan images.

Retrieve and display images.

Annotate, edit, and manipulate images.

Convert, copy, and OCR images.

Append, insert, and replace image pages.

Display and manage thumbnail representations.

Set the Summary properties of images for easier retrieval.

Print, save, and send images.

13
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What Is Document Imaging?
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Imaging for Windows technology brings Imaging functions to many
business and personal users — particularly where Imaging for Windows
is on virtually every desktop running Windows 98, Windows NT 4.0,
and Windows 2000.

The following sections describe the concepts of business and personal
document imaging.

Business Document Imaging

Business document imaging is a technology that converts paper
documents into an electronic form, where they can be automated using
standard computer technology.

Most business information is in the form of paper documents. Industry
analysts report that about 94 percent of business information is on paper
and that 2.7 billion new sheets of paper are filed into folders every single
day.

Paper has obvious advantages, such as portability, ease of use, and low
cost. However, paper also has serious drawbacks. At any given time,
between three and five percent of a company's files are lost or misplaced.
With the average cost of recreating a document at around $180, the cost
of losing important business documents can be an expensive one indeed.

Perhaps paper’s most serious drawback is that paper-based information is
not as readily accessible as computer-based data. A manual business
process, not an automated one, uses paper best. To make matters worse,
paper-based documents and their respective data usually reside separate
from related paper-based documents and their data.

Obtaining information readily or providing “the right information to the
right person at the right time” is difficult and costly with the paper-
based, manual business process. So, while paper is the major information
base of a business, it remains outside of the business information system
because it is not easily and reliably accessible.

Computer-based information, on the other hand, is always readily and
reliably accessible. Business document imaging is the process of turning
paper-based information into computer-based information.

By using a computer to capture paper documents as electronic images,
you can apply all the benefits and power of database, e-mail, networking,
fax, and storage technology to what was once manually processed
information.
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Personal Document Imaging

As is the case with business document imaging, personal document
imaging is the process of turning paper-based information into
computer-based information.

Like business information, most personal information is in the form of
paper documents. From personal correspondence with companies to tax
forms to hobby-related documents and childrens’ drawings, the
information in our personal lives is very much paper-centric.

Paper-based personal documents are also subject to permanent loss and
temporary misplacement. They’re also not as readily accessible as
computer-based documents.

By using a computer to capture personal paper-based documents as
electronic images, you can store letters, tax forms, and receipts in an
organized manner that makes finding them easier. You can preserve
college records, hobby-related documents, and childrens’” drawings for
many years — not to mention share them with family and friends by
sending them over the Internet.

15
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Compiling and Distributing Your Image-Enabled

Application

You need to make sure that you compile your image-enabled application
with the appropriate version of Imaging for Windows.

You also need to make sure that your end users acquire and set up the
appropriate version of Imaging for Windows prior to installing your
software.

The version of Imaging for Windows you need when compiling your
application — and the version your end users need to install — largely
depends on the features you have included in your software.

Compiling Software with Imaging for Windows

If you used a control, property, method, event, or parameter provided
exclusively by a newer version of Imaging for Windows, you must
compile your application with that newer version of Imaging for
Windows.

In addition, you must make sure that your end users purchase and set up
that version of Imaging for Windows to run your software successtully.

Your users can obtain Imaging for Windows from the eiStream Web site,
at:

http://ww. ei stream com

Compiling Software with an Operating System Component
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If you did not use a control, property, method, event, or parameter
provided exclusively by a version of Imaging for Windows — and you
want your application to be used by Imaging for Windows 98, Windows
NT, or Windows 2000 users — you must compile your application with
the appropriate version of Imaging for Windows (98, NT, or 2000).

If you compile your software with an operating system version of
Imaging for Windows, the Imaging for Windows functionality in your
application is only licensed to run on the specific operating system. The
functionality may not be compatible on other operating systems and
Imaging for Windows is non-transferable.

The Imaging for Windows 98, Windows NT, and Windows 2000
controls are free; as such, there are no royalties or licensing fees required.
Your end users must simply set up the appropriate version of Imaging for
‘Windows as a prerequisite to using your program (if they haven’t
already).
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Note: Do not distribute the Imaging OCX files with your application,
because doing so will not install Imaging for Windows correctly.
Instead, have your users set up the entire Imaging for Windows
application to ensure that all of the required software is installed
and registered properly.

= Imaging for Windows 2000 ships as a component of
Windows 2000.

= Imaging for Windows NT 4.0 ships as a component of
Windows NT Workstation 4.0.

= Imaging for Windows 98 ships as a component of Windows
98..

Use of LZW Compression

Imaging for Windows uses LZW, a compression/decompression
technology that is covered by U.S. Patent 4,558,302 (plus its foreign
counterparts, issued or pending). All patents are held by Unisys
Corporation.

eiStream WMS, Incs Imaging for Windows software does not permit
you to use LZW compression or decompression capabilities from any
version of Imaging for Windows for development purposes, or to use or
derive the LZW capabilities from an eiStream third-party application or
other derivative software.

Contact Unisys for licensing information at:

‘Welch Patent Licensing Department
Unisys Corporation, Mail Stop E8-114
Unisys Way

Blue Bell, PA 19424,

Via the Internet, send E-mail to LZW_INFO@UNISYS.COM. Via

facsimile, send inquiries to Welch Patent Licensing Department at
215-986-3090.

17
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Documentation Conventions

This guide uses the following conventions.

Conventions Description
Image, Display, Words in bold with initial capitalization
PasteCompleted indicate names of properties, methods, and
events.
bj ect, argli st In the syntax section, words in lowercase

italics indicate placeholders for
information you must provide.

[expressionlist] | In the syntax section, items appearing
inside square brackets are optional.

{True | Fal se} In the syntax section, braces and a vertical
bar indicate a mandatory choice between
two or more items.

Dim x As IFontDisp This font is used for code examples.

d This character indicates that a line of code
was too long to fit on one line in the
Example window.

You should keep the code on one line in your program, or use the line
continuation character provided by your programming environment.
Refer to the documentation that came with your programming
environment for more information on the line continuation character
and its proper placement in your code.

Note that the U character does not necessarily indicate the proper place
for a line continuation character in your code.

18
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Adding Imaging Using Automation

This chapter explains how to use Automation to image-enable your
applications. It begins by describing the object hierarchy of the Imaging
application and continues by describing how the Imaging application can
function as an Automation server application or an Embedded server
application. The chapter concludes by walking you through a sample
project to help you get started.

In This Chapter

OVBIVIBW ..., 20
The Object HIerarchy ........ccccoooiiiiiii e 20
Automation Server and Embedded Server Modes......................... 22

Demonstration Project .......c.eeiiiieiiiieieee e 28
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Overview

(0

Components are software
modules that can be “plugged
into” applications from other
vendors. They provide end
users with a specific set of
additional functions and
capabilities.

Imaging for Windows features a rich Automation interface that provides
programmatic access to the internal services of the Imaging application.

Using Automation, you can provide your users with the image display
and manipulation functions that are contained within the Imaging
application. You, in effect, make the Imaging application a fully
functional, tested, and trusted component of your application.

Note: The Imaging Preview and Imaging Flow applications cannot be
automated.

In addition to automating the Imaging application from your programs,
you can also automate it from other Automation-capable programs, such
as Microsoft® Word and Excel.

The remainder of this chapter:

* Outlines the Object Hierarchy of the Imaging application.

* Describes how the Imaging application can function as an
Automation server application or an Embedded server application.

* Provides an example of automating the Imaging application from
Microsoft Excel.

The Object Hierarchy

20

The object model of the Imaging application includes:
*  One top-level object, called the Application object;
* One document object, called the ImageFile object; and

* Two objects that support the ImageFile object, called
the Page object and the PageRange object.

Application Object |

*A ImageFile Object ‘
—»{ Page Object ‘

—>‘ PageRange Object |
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Application Object

ImageFile Object

Page Object

The first time you start the Imaging application, it adds the Application
object to the Windows® registry. Imaging Automation exposes only the
Application object for creation. Other programmable objects can be
created by referencing the Application object.

Each object in the hierarchy has its own set of properties and methods.
Refer to Chapter 3 for a description of the properties and methods of
each object.

Use the Application object to create an instance of the Imaging appli-
cation and to control it. The Application object controls every other
object you create as well as the environment of the application; such as
the application’s size and position.

The ImageFile object represents an image document file. Use it to
specify the name of an image file and to provide basic filing functions
such as open, save, close, print, insert, update, and append. Use it also to
provide image manipulation functions such as rotate, create contact sheet,
and perform OCR.

Each Page object represents an image document page. Use it to
manipulate the individual pages of an image file and to provide functions
such as delete, flip, print, rotate, scroll, and perform OCR.

21
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PageRange Object

The PageRange object represents a range of consecutive pages within an
ImageFile object — starting at the StartPage property and ending at the
EndPage property. Use it to manipulate a range of pages and to provide
page manipulation functions such as delete, print, and perform OCR.

Note: Automation is not aware of the actions performed by users
within the Imaging application. The objects known to
Automation remain in the state they were in when last affected
programmatically.

In other words, if users change a displayed object, Automation
does not update that object within its Application object. For
example, if users change the active page, Automation does not
update the ActivePage property.

However, properties and methods are available that let you
determine if a change has occurred. At your option, you can use
them to update the corresponding objects known to
Automation.

Automation Server and Embedded Server Modes

The Imaging application can function as an:

* Automation server application, or an
You can use the AppState
property of the Application
object to determine whether The following sections describe each mode and include examples.
the Imaging application is
running as an Automation
server or an Embedded server.

* Embedded server application.

Automation Server Mode

In every version of Imaging for Windows, the Imaging application can
function as a stand-alone Automation server application.

When automated in this mode, the Imaging application is directed to
display and manipulate an image file that is external to your application;
such as a file resident on a local or network drive. Your program uses the
properties and methods of the Imaging Automation objects to control
the Imaging application and to display and manipulate the image.

The demonstration project, described later in this chapter, is an excellent
example of using the Imaging application as an Automation server
application.

22
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Embedded Server Mode

Examples

Imaging for Windows has several Imaging Automation properties and
methods to manipulate an embedded image document object.

When automated in this mode, the Imaging application is directed to
manipulate an image document object that has been embedded into your
program using, for example, the OLE Container control of Visual Basic.

Depending on how you code your application, you can manipulate the
embedded image document in-place or within the Imaging application
window (refer to the next section for examples).

Note: Remember that the Automation interface allows the in-place
activation of embedded objects only. It does not permit the in-
place activation of linked objects.

This section contains examples that show you how to automate the
Imaging application as a stand-alone Automation server application and
as an Embedded server application.

Note: The example that demonstrates automating the Imaging
application as an Automation server application is more
extensive because:
= The principles behind automating the Imaging application

are similar no matter which mode is used.
= Use of the Imaging application as an Automation server
application is more prevalent.

As an Automation Server Application

This example shows you how to use Visual Basic to automate the
Imaging application as an Automation server application. (Refer to the
code snippet at the end of this section.)

Automating the Imaging application involves a series of programming
steps that begin with the creation of Application and Image File objects
and continue with the application control and image manipulation
functions you want to perform.

23
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(0

After you create an object, you
can access the properties and
methods of the object using
the object variable.

(0

A PageRange object represents
a range of consecutive pages
within an ImagefFile object.

24

To create the Application and Image File Objects

1 Declare the object variables that will contain references to the
Application and Image File objects.

2 Use the Set statement and the CreateObject function of Visual
Basic to create and return a reference to the Application object.

3 Use the Set statement of Visual Basic and the
CreateImageViewerObject method of the Application object to
create and return a reference to the ImageFile object.

With the Application and ImageFile objects instantiated, you can
now manipulate the Imaging application as well as any image the
application displays.

To manipulate the Imaging Application

1 Set the TopWindow property of the Application object to True to
have the Imaging application window remain on top of all other
applications that may be running.

2 Invoke the Open method of the ImageFile object to open and
display an image file. In your call to the Open method, pass the
following parameters:

ImageFile — The path and file name of the image file to display

IncludeAnnotation (optional) — True or False: whether to
display annotations that may be present in the image file

Page (optional) — The number of the image page to display

DisplayUIFlag (optional) — True or False: whether to display the
Open dialog box, which lets end users select the file they want to
display

Now that an image is open and on display, you can manipulate it.
The following paragraphs provide some examples.

— Invoke the RotateLeft method of the Page object to rotate page 1
of the image file 90 degrees to the left. Keep in mind that there is
one Page object for each image page in the file.

— Use the Height property of the Page object to assign the height of
page 1 to the local variable | ngPageHei ght .

— Invoke the Print method of the PageRange object to print pages 1
and 2 on the default printer.

— Set the ActivePage property of the ImageFile object to 2 to
display page 2 of the image file.
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To Close the Image File and Exit the Application

1 Invoke the Close method of the ImageFile object to close the image
file.

2 Invoke the Quit method of the Application object to exit the
application.

3 Set the object variables to Nothing to free system resources.

'Declare variables
Dim objApp As Object
Dim objImg As Object
Dim vntPrtRange As Variant
Dim TngPageHeight As Long

'Create the Application object (Standard VB call)
Set objApp = CreateObject("Imaging.Application")

'Create the ImageFile object
Set objImg = objApp.CreatelmageViewerObject(1)

'Set the application's TopWindow property to TRUE (stay on top)
objApp.TopWindow = True

'Call the ImageFile object Open Method to display page 1 of myimage.tif
objImg.0Open "c:\images\myimage.tif", True, 1, False

'Create and rotate one Page object
objImg.Pages(1l).Rotateleft

'Return the height of the image from the Page object
TngPageHeight = objImg.Pages(1l).Height

'Create a PageRange object and print pages 1 and 2
vntPrtRange = objImg.Pages(1,2).Print

'Display page 2 of the image
objImg.ActivePage = 2

"Close ImageFile object and quit the application
objImg.Close
objApp.Quit

'Release system resources
Set objApp = Nothing
Set objImg = Nothing

25
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Methods Not Available in Automation Server Mode

You cannot use the following methods when the Imaging application is
functioning as an Automation server application:

* SaveCopyAs method of the ImageFile object
* Update method of the ImageFile object

As an Embedded Server Application

The following sections demonstrate how to automate the Imaging
application as an Embedded server application. The examples assume you
are embedding an image document object into a Visual Basic application
using the OLE Container control.

Example 1

In this example, the Imaging application displays the embedded image
document in a separate window for editing.

Set objApp = CreateObject("Imaging.Application")

Set objImg = objApp.CreatelmageViewerObject(1)
oleImg.CreateEmbed("", "Imaging.Document")
olelImg.DoVerb vbOLEQOpen

objImg.InsertExistingPages "Test.tif", 1, 1, 1, False

Example 2

In this example, the Imaging application is in-place active and displays a
subset of its menus within your application. The menus provide access to
functions that let users edit the image document object “in-place” —
that is, within your application.

Set objApp = CreateObject("Imaging.Application")
oleImg.CreateEmbed("", "Imaging.Document")
oleImg.DoVerb vbOLEShow

Set objImg = objApp.CreatelmageViewerObject(1)
objImg.InsertExistingPages "Test.tif", 1, 1, 1, False
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Example 3

In this example, the Imaging application displays the embedded image
document in an instance of the Imaging application that is already
running.

oleImg.CreateEmbed("", "Imaging.Document")
oleImg.DoVerb vbOLEOpen

Set objApp = CreateObject("Imaging.Application")
Set objImg = objApp.CreatelmageViewerObject(1)

Properties and Methods Not Available in Embedded Server
Mode

You cannot use the following properties and methods when the Imaging
application is functioning as an Embedded server application:

= Edit property of the Application object

* Height and Width properties of the Application object

* ImageView property of the Application object (if the application is
in-place active)

* Left property of the Application object

* Top property of the Application object

* Close method of the ImageFile object

*  FindOIServerDoc method of the ImageFile object
* New method of the ImageFile object

* Open method of the ImageFile object

*  Quit method of the Application object (if the application is in-place
active)

* SaveAs method of the ImageFile object

27
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Demonstration Project

This section demonstrates
how to automate the
Imaging application from
Microsoft Excel.

While a wide-ranging dis-
cussion of every Imaging
function is beyond the scope
of this chapter, the infor-
mation presented here is
sufficient to get started.

The demonstration project
was developed using
Microsoft Visual Basic for
Applications and Excel.

Even if you are not going to
automate the Imaging
application, you'll find the
section in this chapter on
View Modes useful.

View Modes

(0

Developers using the Imaging
ActiveX controls can use

the Image Edit and Image
Thumbnail controls to simulate
the View Mode behavior des-
cribed in this section. Refer to
the ActiveX controls Help for
more information.

28

To help you use Automation to image-enable your applications, a
demonstration project — called Automation From Excel — shows you
how to:

* Invoke the Imaging application and open an image.
* Obtain the page count.

* Rotate an image page.

*  Set the desired view mode.

* Close the image and the application.
Note: Chapter 3 of this guide describes the properties and methods of
each Imaging Automation object.

Before walking through the demonstration project, read the following
section, which describes the view modes of the Imaging application.
Chapter 4 of this guide describes the concepts of image display, page
counts, multipage image files, and image rotation.

The Imaging application has three view modes that enable users to view
and work with image files. Each view mode has its own set of advantages
and capabilities.

The ImageView property of the Application object enables you to
invoke — most likely in response to user input — any one of the three
view modes. You should consider making view mode selection available
to your users when automating the Imaging application.

The following sections describe the view modes.
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One Page

The One Page view mode lets users display image files one page at a
time. It lets users display image pages in the entire window while
maintaining complete access to the menus, toolbars, and functions of
the application.

£ Chapterl tif - Imaging I =] 3
File Edit “iew Page Zoom Tools Annotation Help

D8] & &=|e] 2|« &la|n]s BB ks
2| 2|22 ofr @)% @0 =] [ ] E

||

=]
Introducing Imaging for Windows

This chapaer discuses basic imaging comoeprs and deseribes the

funcesanms salible weth Imaging for Wisdows

In this Chapter

Basic imaging Cancepts 2

Imaging for Windows &
PRSEINS ST EIRY I E =i EYE:)
For Help. press F1 |53.50% |Pagelof4 4
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Thumbnail

The Thumbnail view mode lets users display image files as a series of
thumbnail images — one for each image page. It lets users:

*  View multiple image pages simultaneously.
* Rearrange pages using drag and drop.
*  Delete pages.

* Drag and drop pages to and from other applications that support drag
and drop functionality.

Keep in mind that some Imaging functions — like annotation and
zoom — are not available in this mode because they are not appropriate
for use on such small images.

El Chapterl tif - Imaging
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Page and Thumbnails

The Page and Thumbnails view mode is a combination of the first two
view modes. It enables users to display image files one page at a time and
as series of thumbnail images — one for each image page in the file.

This view mode lets users perform Imaging tasks that are available to

both the One Page view mode and the Thumbnail view mode.

E] Chapterl tif - Imaging =] B3
File Edit %iew FPage Zoom Tools Annotation Help

D& & 2= ol &lat] 7|88 [peex
B 222 ofr &5 @ s 2 mE
4-|->|

=l

Introducing Imaging for Windows

I

N E RN E LR E R E = |
For Help, press F1 [39.28% |1 of 4 pages selected
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Example

Users of Excel may want to display and manipulate an image file
referenced within a spreadsheet.

Scenario

In her role as a product manager for a major computer company, Eileen
regularly uses Microsoft Excel to create product configurations of PCs
sold on contract to government agencies.

After she completes a configuration spreadsheet, she typically submits it
to review via e-mail. In the past, several reviewers have requested that she
also include a scanned copy of the contract.

At a recent employee meeting, Eileen asked you if there was any way her
reviewers could display a scanned contract from Excel. Knowing that
Imaging for Windows is on every desktop in the company, you told her
that you could automate the Imaging application from Excel to give her
reviewers quick access to a scanned contract, or any other image file for
that matter.

All Eileen needs to do is:
1 Scan the contract using Imaging for Windows.
2 Import your code module into her Excel spreadsheet.

3 Enter the path and file name of the scanned contract in Cell A1 of the
spreadsheet.

4 Send both the image file and the spreadsheet file to her reviewers.

The Automation From Excel Project

The file names for the
Automation From Excel project
are Aut oFr onExcel . bas,

| magi ngAut omat i on. x| s,
and Facc. tif.
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As stated previously, the Automation From Excel project demonstrates:

Invoking the Imaging application and opening an image from Excel.
Obtaining the page count.

* Rotating an image page.

*  Setting the desired view mode.

* Closing the image and the application.

The project consists of the following files:

AutoFromExcel.bas — A Visual Basic for Applications (VBA) code
module that contains macros that automate the Imaging application.

ImagingAutomation.xls — A sample spreadsheet that contains the
AutoFromExcel.bas code module.
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Facc.tif — A sample TIFF image file that simulates the title page of a
government contract.

The AutoFromExcel.bas code module contains the following macros:
f_Initialize App() — Initializes the Imaging application.

s_DispImg() — Displays the image file.

s_FindServerDoc() — Locates an image document residing on a server.

s_GetPagecount() — Obtains the number of pages in the image file
and displays it in a worksheet cell.

s_RotateImg() — Rotates the image 90 degrees to the left.

s_ViewSingle() — Places the Imaging application in the One Page
view mode.

s_ViewThumbnails() — Places the Imaging application in the
Thumbnail view mode.

s_ViewThumbAndSingle() — Places the Imaging application in the
Page and Thumbnails view mode.

s_CloseImg() — Closes the image file and exits the Imaging
application.

The AutoFromExcel.bas code module uses the following Automation
methods to provide the Imaging functions:

Open method (ImageFile object) — Opens the image file in the
Imaging application.

CreateImageViewerObject method (Application object) — Creates
and returns an ImageFile object.

RotateLeft method (Page object) — Rotates the image 90 degrees
counterclockwise.

Close method (ImageFile object) — Closes the ImageFile object.

Quit method (Application object) — Exits the application.
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Opening the Spreadsheet File

Start Excel and then open the | magi ngAut omat i on. x| s file. The
sample spreadsheet appears.

™ Microsoft Excel - ImagingAutomation.xls
”’i‘: File Edit View I[nsert Format Tools Data Window Help ;lﬁl_l
o= BRI oo A% z AL IR D |
A1 J = | D Automation\FACC tif
A B | C 'D| E | F |2
1 |DAAutomationtH 3
Ext.

2 |Model Number Comp No. Description Qity |Price | Price

3 |SWDX-233 SWDX Workstation 233MHZ MMX

4 Dx-F-233 233MHz Systerm Unit 1 $1,239 $1,239

5 Dx-98KE Windows98 Keyboard 1 $59 $&9

G Dx-HF37 37-M HF Radio Adapter 1 $999  $999

7 Dx-EDO-32 | 32MB EDO Memory 40 $139 0 $556

g Dx-4-VIDED 4AME Video DRAM 1 $59 $&9

9 DH-MOM-15 15" Maonitor 1 $299  $299

10 DX-IDE-4GE 4 3GE IDE drive 20 %179 $358 L
11 DX-IDE-CD | IDE CD-ROM 1 $69 $69

12 DX-MOUSE Mouse 1 $39 $39

13 D¥-RCS-37  |HF Controller Software 1 $299  $299

14 | Total $4,036 =
|44 [» [, Sheet1 { Sheet? f Sheetd / |4] | ¥
Ready | | iy’

Opening and Displaying the Image File

Give focus to Cell A1, which contains the path and file name of the

sample TIFF image file.
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On the Tools menu, point to Macro and then click Macros. The
Macro dialog box appears.

. Microsoft Excel - ImagingAutomation.xls !EIB
“‘F: File Edit View Insert Format Tools Data Window Help _|E|i|
DEE ey iRt o -~ | a® = sslzlindad @ |

o1
Macro Mame: | F |T
1 DAL Is_DispImg 3 |
Closel - .
AL e — N |
3 | SWDO [s_GetPagecount
5_RotateImg
g s_ViewSingle Step Into | $1 ;gg
s_MiewThumbandSingle
B s_WiewThumbnails Edit | $999
7 $556
8 S R
g $299
- Delete
10 - 4' $358
11 Macros in: All Open Workbooks j Options. .. $69
12 Description £39
13 $299
14 | Total $4,036 |z
[4[4[» [pI], Sheet  SheetZ 7 Sheet3 / KN | n
Ready [ I e

Click the s_DispImg macro and then click Run.

When the macro runs, code in the Gener al Decl ar ati ons area of
the code module defines the object variables that contain references to
the Application and Image File objects.

Dim objApp As Object
Dim objImg As Object
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Then, the s_DispImg() subroutine executes its code.

The s_DispImg() subroutine obtains the path and file name of the

image file to open from the active cell of the spreadsheet. Then it assigns

the path and file name to the st r Current Fi | e local variable.

Sub s_DispImg()

Dim strCurrentFile As String
Dim strCurrentImageName As String

'Get file name to display from spread sheet
strCurrentFile = ActiveCell.Value

'"If the Application object not created, create it.
If objApp Is Nothing Then
If f_InitializeApp() = False Then 'Continue if successful
Exit Sub
End If
End If

'Make the Imaging application on-top.
objApp.TopWindow = True

On Error Resume Next "If no file is open.
'Get the name of the open Image file.
strCurrentImageName = objImg.Name

On Error GoTo O 'Reset error handler

If strCurrentimageName <> "" Then
"Always close existing image file before opening a new one.
objImg.Close

End If

On Error GoTo OpenlmageMethodError
'Open the Image file in the ActiveCell
objImg.0Open strCurrentFile

Exit Sub
OpenImageMethodError:
sMsg = "Error => " & Str$(Err.Number) & " " & Err.Description

MsgBox (sMsg)
'Close the Imaging application
s_Closelmg

End Sub
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Next, the subroutine checks to see if an instance of the Imaging
application exists. If it does not, it invokes the f Initialize App()
function.

The f_InitializeApp() function uses the Set statement and the
CreateObject function of Visual Basic to create and return a reference
to the Application object. Then it uses the Set statement of Visual Basic
and the CreateImageViewerObject method of the Application object
to create and return a reference to the ImageFile object.

Function f_InitializeApp() As Boolean

Set objApp = Nothing

Set objImg = Nothing

On Error GoTo oldname

Attempt to create app object using current name
If this fails try the older name

Set objApp = CreateObject("Imaging.Application")

GoTo viewer

oldname: On Error GoTo 0O
Set objApp = CreateObject("WangImage.Application")
viewer: On Error GoTo 0
Set objImg = objApp.CreatelmageViewerObject(1l)
f_InitializeApp = True

End Function

With the Application and ImageFile objects now fully instantiated,
control returns to the s_DispImg() subroutine.

The _DispImg() subroutine sets the TopWindow property of the
Application object to True to have the Imaging application window
remain on top of all other applications that may be running.

Then it checks to see if an image file is already displayed by examining
the value of the Name property of the ImageFile object. If the Name
property is not blank, the subroutine invokes the Close method of the
ImageFile object to close the displayed image file.
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Next, the subroutine invokes the Open method of the ImageFile object,
passing to it the path and file name of the image to display (from
strCurrent Fil e). The Open method opens the image file in the
Imaging application window.

™ Microsoft Excel - ImagingAutomation.xls

”ﬁxlziln Fdit View Thesrt Farmat Tonle Data Window Heln Ilql XI
£ FACC.tif - Imaging _ O] x|

File Edit %iew FPage Zoom Tools Annotation Help
D@l & sl o &lal 8|5 [m5% ]

[ooln| @] B o w| &5 @ | @] [ s

swdx solutions incorporated

Federal Aviation and
Communication Contract

[-]]
For Help. press F1 |25 50%  |Page 1 of 1 A
13 DX-RCS-37 HF Controller Software 1 %299 $299
14 | Total $4,036 =
|44 [» [, Sheet1 { Sheet? f Sheetd / |4] | ¥
Ready [ [ 4

Now that the image is open and on display, you can use some of the
other macros to manipulate it and the Imaging application.
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Obtaining the Page Count

On the Tools menu in Excel, point to Macro and then click Macros.
The Macro dialog box appears.

Click the s_GetPagecount macro and then click Run. The
s_GetPagecount() subroutine executes its code.

The subroutine obtains the page count from the PageCount property of
the ImageFile object and assigns it to the | ngPageCount local variable.
Then it invokes the Cells function of Excel to display the page count
(from | ngPageCount ) in the cell adjacent to the active cell on the
spreadsheet.

Sub s_GetPagecount()

End Sub

Dim TngPageCount As Long

If objImg Is Nothing Then
MsgBox ("Please Open an Image file first")
Exit Sub

End If

'Get the page count.
IngPageCount = objImg.PageCount

'Put the page count in the adjacent column.
Cells(ActiveCell.Row, ActiveCell.Column + 1) = TngPageCount
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Rotating an Image Page

On the Tools menu in Excel, point to Macro and then click Macros.
The Macro dialog box appears.

Click the s_RotateImg macro and then click Run. The
s_RotateImg() subroutine executes its code.

The subroutine obtains the page number of the currently displayed image
page from the ActivePage property of the ImageFile object, and assigns
it to the | ngAct i vepage local variable. Then it invokes the
RotateLeft method of the Page object to rotate the displayed image
page 90 degrees to the left.

Sub s_RotatelImg()
Dim IngActivepage As Long
If objImg Is Nothing Then
MsgBox ("Please open an image file first")
Exit Sub
End If

IngActivepage = objImg.ActivePage
objImg.Pages(IngActivePage).Rotateleft

End Sub




Adding Imaging Using Automation

Setting the One Page View Mode

On the Tools menu in Excel, point to Macro and then click Macros.
The Macro dialog box appears.

Click the s_ViewSingle macro and then click Run. The
s_ViewSingle() subroutine executes its code.

The subroutine invokes the ImageView method of the Application
object with a parameter value of 0, which places the Imaging application
in the One Page view mode.

Sub s_ViewSingle()

If objImg Is Nothi
MsgBox ("Ple
Exit Sub
End If

'Place the Imagi
objApp.ImageView

End Sub

ng Then
ase Open an Image file first")

ng application in One Page view mode.
=0

Setting the Thumbnail View Mode

On the Tools menu in Excel, point to Macro and then click Macros.
The Macro dialog box appears.

Click the s_ViewThumbnails macro and then click Run. The
s_ViewThumbnails() subroutine executes its code.

The subroutine invokes the ImageView method of the Application
object with a parameter value of 1, which places the Imaging application
in the Thumbnail view mode.

Sub s_ViewThumbnails()

If objImg Is Nothing Then
MsgBox ("Please Open an Image file first")
Exit Sub

End If

'Place the Imaging application in Thumbnail view mode.
objApp.ImageView = 1

End Sub
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Setting the Page and Thumbnails View Mode

On the Tools menu in Excel, point to Macro and then click Macros.
The Macro dialog box appears.

Click the s_ViewThumbAndSingle macro and then click Run. The
s_ViewThumbAndSingle() subroutine executes its code.

The subroutine invokes the ImageView method of the Application
object with a parameter value of 2, which places the Imaging application
in the Page and Thumbnails view mode.

Sub s_ViewThumbAndSingle()

End

If objImg Is Nothing Then
MsgBox ("Please Open an Image file first")

Exit Sub

End If

'Place the Imaging application in Page and Thumbnails view mode.

objApp.ImageView

Sub

-2

Closing the Image File and the Imaging
Application

On the Tools menu in Excel, point to Macro and then click Macros.
The Macro dialog box appears.

Click the s_CloseImg macro and then click Run. The s_CloseImg()
subroutine executes its code.

The subroutine invokes the Close method of the ImageFile object to
close the currently displayed image file. Then it invokes the Quit
method of the Application object to close the Imaging application.
Finally, it sets the object variables to Nothing to free system resources.

Sub

End

s_CloseImg()

On Error Resume Next

objImg.Close

objApp.Quit

'Close open image
'Quit Automation application

Set objImg = Nothing 'Destroy Image object

Set objApp = Nothing 'Destroy Application object
On Error GoTo O 'Reset Error handler

Sub
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Overview

This chapter describes the Automation enables you to control the Imaging application program-
properties and methods of

each object in the Imaging
application object hierarchy.

matically from within your application. Using it, you can provide your
end users with all of the capabilities of the Imaging application.

Each object has its own set of properties and methods. The remainder of
this chapter describes each one.

Note: Refer to Chapter 2 of this guide for more information about
using Automation to image-enable your applications.

Application Object

The Application object is a top-level object that controls every other
object you create. The Application object also allows you to set the
environment. For example, you can control the size and position of the
Imaging application window and the visibility of scroll bars, the status
bar, and the toolbar.

Application Object Properties

The following table lists the Application object properties. Note
that the properties that affect the displayed image (for example,
DisplayScaleAlgorithm, ImagePalette, and Zoom) affect every
image displayed in the Application object.

Application Object Properties

Property Description

ActiveDocument Returns the active ImageFile object.

AnnotationPaletteVisible | Sets or returns the visibility of the application's annotation

palette.
Application Returns the Application object.
AppState Returns the state of the image viewer application.
DisplayScaleAlgorithm Sets or returns the scaling algorithm used for displaying images.
Edit Sets or returns the application’s ability to edit the displayed
object.
FullName Returns the file specification for the Application object.
Height Sets or returns the distance between the top and bottom edge

of the application window.

ImagePalette Sets or returns the image palette used for image display.
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Application Object Properties (cont.)

Property

Description

ImageView

Sets or returns the present image view.

ImagingToolBarVisible

Sets or returns the visibility of the application’s scan toolbar.
Not available in all releases.

Left Sets or returns the distance between the left edge of the physi-
cal screen and the main application window.

Name Returns the name of the Application object.

Parent Returns the Application object.

Path Returns the path specification for this application’s executable
file.

ScannerIsAvailable Sets or returns the state of the scanner.

ScanToolBarVisible Sets or returns the visibility of the application’s imaging
toolbar.

ScrollBarsVisible Sets or returns the visibility of the application’s scroll bars.

StatusBarVisible Sets or returns the visibility of the application’s status bar.

ToolBarVisible Sets or returns the visibility of the application’s toolbar.

Top Sets or returns the distance between the top edge of the physi-
cal screen and application’s window.

TopWindow Sets or returns the application’s top window flag.

Visible Returns the visibility of the application.

WebToolBarVisible Sets or returns the visibility of the web toolbar.

Width Sets or returns the distance between the left and right edges of
the application’s window.

Zoom Sets or returns the zoom factor for image display.

ActiveDocument Property

Description Returns the active ImageFile object in the Application object. This is a read-only property.

Usage Appl i cati onObj ect. Acti veDocunent

Data Type Object.

Example

'This exanpl e returns the | mageFil e object

Dimlnmg as Object
Set Img = App. Acti veDocunent

in the application.
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AnnotationPaletteVisible Property

Description Sets or returns the visibility of the annotation palette. This is a read/write property.
Usage Appl i cati onCbj ect. Annot ati onPal etteVisible = [{True| Fal se}]
Data Type Integer (Boolean).

Remarks The AnnotationPaletteVisible property settings are:

Setting Description
True (Default) The annotation palette is visible.
False The annotation palette is not visible.

Application Property

Description Returns the Application object. This is a read-only property.
Usage Appl i cationCbj ect. Application

Data Type Object.

Example 'This exanpl e returns the Application object.
Di m Parent As (ObjectSet Parent = App. Application

AppState Property

Description Returns the state of the Application object. The state indicates whether the application is
running as an embedded or automation server. This is a read-only property.

Usage Appl i cati onCbj ect. AppSt at e
Data Type Short.
Remarks The AppState property settings are:

Setting Description

1 The application is running as an embedded server.

2 The application is running as an automation server.

DisplayScaleAlgorithm Property

Description Sets or returns the scaling algorithm used for displaying images. This is a read/write
property.

Usage Appl i cati onObj ect. Di spl ayScal eAl gorithm [ =val ue]

Data Type Short.
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Remarks

The DisplayScaleAlgorithm value can be specified before or after an image is displayed. The
property settings are:

Setting Description

0 (Default) Normal decimation.

1 Gray4 — 4-bit gray scale (16 shades of gray).

2 Gray8 — 8-bit gray scale (256 shades of gray).

3 Stamp — Represents the image as a thumbnail.

4 Optimize — Changes the display scale algorithm based on the image type of

the displayed image. Black and white images are scaled to gray. Palettized
4- and 8-bit, RGB, and BGR images remain color.

Note: This property must be set prior to opening the ImageFile object. For this property to
take effect after an image is open, you must reopen the image.

Edit Property

Description Sets or returns the Application object’s ability to edit the displayed object. You should set

Usage
Data Type

Remarks

the Edit property prior to opening each ImageFile object. This is a read/write property.
ApplicationObject.Edit = [{True| Fal se}]
Integer (Boolean).

The Edit property settings are:

Setting Description
True (Default) Image editing is available.
False The displayed object cannot be changed.

Note: You must set the Edit property prior to opening the ImageFile object. You can only
set the Edit property once in the current session.

FullName Property

Description Returns the file specification for the Application object, including the path. This is a read-

Usage
Data Type

only property.
Appl i cati onObj ect . Ful | Nane

String.
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Height Property

Description Sets or returns the distance, in pixels, between the top and bottom edge of the Application
object’s window. This is a read/write property.

Usage Appl i cati onCbj ect. Hei ght [ =val ue]
Data Type Long.

Remarks  This property must be set prior to opening the ImageFile object. It only takes effect if the
Width, Top, and Left properties are also set. If you set the Height property to less than
the minimum allowable window size, the value is ignored. The minimum setting is usually

27.

The Height property only returns the value that you set programmatically prior to opening
the window. It does not return changes made to the window after it has been opened.

ImagePalette Property

Description Sets or returns the image palette used to display an image. This is a read/write property.

Note: The ImagePalette property must be set prior to opening the ImageFile object. For
this property to take effect after an image is open, you must reopen the image.

Usage Appl i cationObj ect. | nagePal ette [=val ue]
Data Type Short.

Remarks The ImagePalette property settings are:

Setting Description

0 (Default) Custom

1 Common

2 Gray8 — 8-bit grayscale (256 shades of gray)
3 R GB24 — 24-bit (millions of colors)

4 Black and white

ImageView Property
Description Sets or returns the present image view. This is a read/write property.

Usage Appl i cationObj ect. | nageVi ew [ =val ue]

Data Type Short.
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Remarks

See Also

The ImageView property settings are:

Setting Description

0 (Default) One page view
1 Thumbnails view
2 Page and Thumbnails view

The ImageView property and the ImageFileObject.ActivePage property have the
following relationships:

View Relationship
One Page (Default) The active page is displayed.
Thumbnails The active page appears in thumbnail view.

Page and Thumbnails The active page is the page that is displayed.

ImageFileObject.ActivePage property.

ImagingToolBarVisible Property

Description Sets or returns the visibility of this Application object’s imaging toolbar. This is a read/write

Usage
Data Type

Remarks

property.
Appl i cati onObj ect . | magi ngTool Bar Vi si bl e = [{True| Fal se}]
Integer (Boolean).

The ImagingToolBarVisible property settings are:

Setting Description
True (Default) The imaging toolbar is visible.

False The imaging toolbar is not visible.

Left Property

Description Sets or returns the distance, in pixels, between the left edge of the physical screen and the

Usage
Data Type

Remarks

Application object’s window. This is a read/write property.
Appl i cationObject. Left [=val ue]
Long.

The Left property must be set prior to opening the ImageFile object. This property only
takes effect if the Height, Width, and Top properties are also set.

The Left property only returns the value that you set programmatically prior to opening
the window. It does not return changes made to the window after it has been opened.
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Name Property
Description Returns the name of this Application object. This is a read-only property.

Usage Appl i cati onCbj ect. Name
Data Type String.

Parent Property

Description Returns the parent of the Application object. This is a read-only property.
Usage Appl i cati onObj ect. Parent

Data Type Object.

Path Property

Description Returns the path specification for the Application object’s executable file. This is a read-
only property.

Usage Appl i cati onObj ect. Pat h
Data Type String.

ScannerisAvailable Property

Description Sets or returns the availablity of the scanner. This is a read/write property.
Usage Appl i cati onCbj ect. Scanner | sAvail abl e = [{True| Fal se}]
Data Type Integer (Boolean).

Remarks The ScannerIsAvailable property settings are:

Setting Description

True (Default) The scanner is available. If no scanner is attached to the system, this
property setting is False.

False The scanner is unavailable.

ScanToolBarVisible Property

Description Sets or returns the visibility of this Application object’s scan toolbar. This is a read/write
property.
Usage Appl i cati onObj ect. ScanTool Bar Vi si bl e = [ {True| Fal se}]

Data Type Integer (Boolean).
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Remarks The ScanToolBarVisible property settings are:

Setting Description

True The scan toolbar is visible.

False (Default) The scan toolbar is not visible.

ScrollBarsVisible Property

Description Sets or returns the visibility of the Application object’s scroll bars. This is a read/write
property.

Usage ApplicationObject. ScrollBarsVisible = [{True| Fal se}]

Data Type Integer (Boolean).

Remarks The ScrollBarsVisible property settings are:

Setting Description
True (Default) The scroll bars are visible.

False The scroll bars are not visible.

Note: The ScrollBarsVisible property must be set prior to opening the ImageFile object.
For this property to take effect after an image is open, you must reopen the image.

StatusBarVisible Property

Data Type Sets or returns the visibility of this Application object’s status bar. This is a read/write
property.

Usage ApplicationObject. StatusBarVisible = [{True| Fal se}]

Data Type Integer (Boolean).

Remarks The StatusBarVisible property settings are:

Setting Description

True (Default) The status bar is visible.

False The status bar is not visible.

ToolBarVisible Property

Data Type Sets or returns the visibility of this Application object’s standard toolbar. Read/write
property.
Usage Appl i cati onObj ect. Tool BarVisible = [{True| Fal se}]

Data Type Integer (Boolean).
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Remarks The ToolBarVisible property settings are:

Setting Description
True (Default) The toolbar is visible.

False The toolbar is not visible.

Top Property

Description Sets or returns the distance, in pixels, between the top edge of the physical screen and main
application window. This is a read/write property.

Usage Appl i cati onCbj ect. Top
Data Type Long.

Remarks The Top property must be set prior to opening the ImageFile object. This property only
takes effect if the Height, Width, and Left properties are also set.

The Top property only returns the value that you set programmatically prior to opening
the window. It does not return changes made to the window after it has been opened.

TopWindow Property

Description Sets or returns this Application object’s top window flag. This is a read/write property.
Usage Appl i cationQbj ect. TopW ndow = [{True| Fal se}]

Data Type Integer (Boolean).

Remarks The TopWindow property settings are:

Setting Description

True The application is a stay-on-top window.
False (Default) The application is not a stay-on-top window.
Example ' Thi s exanpl e makes the application wi ndow a stay-on-top w ndow.

App. TopW ndow = True

Visible Property
Description Returns the visibility of the Application object. This is a read-only property.

Usage Appl i cati onObj ect. Visible
Data Type Integer (Boolean).
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Remarks The Visible property settings are:

Setting Description
True The application is visible.

False (Default) The application is not visible.

WebToolBarVisible Property

Description Sets or returns the visibility of this Application object’s web toolbar. This is a read/write
property.

Usage Appl i cati onObj ect. WebTool BarVi sible = [{True| Fal se}]

Data Type Integer (Boolean).

Remarks The WebToolBarVisible property settings are:

Setting Description

True The web toolbar is visible.

False (Default) The web toolbar is not visible.

Width Property

Description Sets or returns the distance, in pixels, between the left and right edges of the Application
object's window. This is a read/write property.

Usage Appl i cationObj ect. Wdth [=val ue]
Data Type Long.

Remarks The Width property must be set prior to opening the ImageFile object. This property only
takes effect if the Top, Left, and Height properties are also set. If you set the Width
property to less than the minimum allowable window size, the value is ignored. The
minimum setting is usually 112.

The Width property only returns the value that you set programmatically prior to opening
the window. It does not return changes made to the window after it has been opened.

Zoom Property

Data Type Sets or returns the zoom factor used for displaying images. This is a read/write property.
Usage Appl i cati onObj ect. Zoom [ =val ue]

Data Type Float.

Remarks The zoom factor is a percent value.

Example ' This exanpl e sets the zoom factor to 100%
App. Zoom = 100

53



| Chapter 3

' This exanpl e returns the current zoom factor.
X = App. Zoom

Application Object Methods

The following table lists the Application object methods.
Application Object Methods

Method Description

CreateImageViewerObject | Creates an Imaging object of the specified class.

FitTo Displays the image at the specified zoom option.
Help Displays online Help.
Quit Exits this application and closes all open objects.

CreatelmageViewerObject Method

Description Creates and returns an ImageFile object. The ImageFile object is empty, with no image file
associated with it. Use the object's Open or New method to associate a specific image file.

Usage Appl i cati onObj ect . Creat el nageVi ewer Obj ect ([ Obj ect C ass] )
Data Type Object.
Remarks This method only supports the ImageFile object, for which the setting is 1.

Example "This exanpl e creates an | nmageFile object.
Dmlnmg as oject
Set I nmg = App. Creat el nageVi ewer Obj ect (1)

FitTo Method

Description Displays the current image at the specified zoom option. This method updates the
Application object’s Zoom property with the actual zoom factor.

This method affects each view as follows:

View Display
One Page The page is zoomed.
Thumbnails No effect — The Application property is changed and aftects

other views when they are used.

Page & Thumbnails The page is zoomed — No effect on thumbnails.
Usage ApplicationCbject.FitTo (ZoonmOpti on)
Data Type Short.
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Remarks ZoomOption settings are:

Setting Description
1 Best fit

2 Fit to width
3 Fit to height
4 Actual size

Help Method

Description Displays the Imaging online Help table of contents.
Usage Appl i cationObj ect. Hel p

Quit Method

Description Closes all open objects and exits the application. The Application object is no longer active
or available.

Usage Appl i cationObject. Quit
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ImageFile Object

An ImageFile object represents an image file. An ImageFile object can have

*  One Page object, representing the currently displayed page of the ImageFile object.

*  One or more PageRange objects, each representing different and possibly overlapping
page ranges.
ImageFile Object Properties

The following table lists the ImageFile object properties.
ImageFile Object Properties

Property Description
ActivePage Sets or returns the ImageFile object’s current page number.
Application Returns the Application object.
FileType Returns the ImageFile object’s file type.
Name Returns the name of the active image file.

OCRLaunchApplication || yunches an application with an output file after OCR*®
processing is complete.

OCROutputFile Sets or returns the output file for OCR processing.

OCROutputType Sets or returns the output file format for OCR processing.

PageCount Returns the number of pages in the ImageFile object.

Parent Returns the parent of the ImageFile object.

Saved Returns a flag indicating whether or not the file has ever
been saved.

a. TextBridge[l OCR technology by ScanSoft.

ActivePage Property
Description Sets or returns the ImageFile object’s active page number. This is a read/write property.

Setting the ActivePage property to a page number causes that page to become active,
which updates the display if the Application object is visible. Refer to the Application
object’s ImageView property for more information about the relationships between the
active page and different views of the page.

Page selection and navigation by the end-user have no effect on the ActivePage property.
The active page is always the active page according to automation.

Note: |If you set the ActivePage property to a page number beyond those contained in
the document, an error is returned.
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Usage I mageFi | eCbj ect . Acti vePage [ =val ue]
Data Type Long.
Remarks The number is the page number value.

See Also ApplicationObject.ImageView property.

Application Property

Description Returns the Application object. This is a read-only property.
Usage I mageFi | eObj ect. Application

Data Type Object.

Example 'This exanpl e returns the Application object.
Di m Parent As (Obj ect
Set Parent = Ing. Application

FileType Property

Description Returns the file type of this ImageFile object. This is a read-only property.
Usage I mageFi | eQoj ect. Fi | eType

Data Type Short.

Remarks The FileType property settings are:

Setting Description

Unknown
TIFF

Not supported
BMP

PCX

DCX
JPG-JFIF

XIF

GIF

WIFF

O X NN N U N, O

Name Property

Description Returns a string that contains the name of the active image file. This is a read-only
property.

Usage | mageFi | eCbj ect . Nane
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Data Type String.

OCRLaunchApplication Property

Description Launches the Application object with an output file after OCR processing is complete.
This is a read/write property.

Usage I mageFi | eCbj ect . OCRLaunchAppl i cation = [{True| Fal se}]
Data Type Integer (Boolean).
Remarks The OCRLaunchApplication property settings are:

Setting Description
True (Default) Launch the application.

False Do not launch the application.

OCROutputFile Property

Description Sets or returns the output file name. If blank, the SaveAs dialog box is displayed. This is a
read/write property.

Usage I mageFi | eCbj ect. OCRQut put Fil e = [Fi | eNane]
Data Type String.

OCROutputType Property

Description Sets or returns the output file type. This is a read/write property.

[ Type]

Usage | mageFi | eQbj ect . OCRQut put Type
Data Type Long.
Remarks The OCROutputType property results are:

Setting Description

0 Word for Windows/RTF
1 WordPerfect

2 HTML

3 Text

PageCount Property

Description Returns the number of pages in this ImageFile object. This is a read-only property.
Usage I mageFi | e(bj ect . PageCount

Data Type Long.
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Parent Property
Description Returns the parent of the ImageFile object. This is a read-only property.
Usage I mageFi | eCbj ect . Par ent
Data Type Object.
Example 'This exanpl e returns the parent of the |InmageFile object.
Di m App As Obj ect
App = | ng. Parent
Saved Property
Description Returns the saved state of the ImageFile object. Read-only property.
Usage I mgeFi | e(hj ect . Saved
Data Type Integer (Boolean).

Remarks The Saved property settings are:

Setting Description

True The ImageFile object has been saved and has not changed since it was last saved.
False The imageFile object has never been saved and has changed since it was created;

or, it has been saved but has changed since it was last saved.

Example "This exanple returns the saved state of the file.
bl sSaved = | ng. Saved

ImageFile Object Methods

The following table lists the ImageFile object methods.
ImageFile Object Methods

Method Description
AppendExistingPages Appends existing pages to the end of the ImageFile object.
Close Closes the ImageFile object.

CreateContactSheet Saves a contact sheet rendition of the ImageFile object.

FindOIServerDoc Finds Imaging 1.x documents and WMS Imaging documents.
Not available when the application is running as an embedded
server.

Help Displays online Help.

InsertExistingPages Inserts existing pages in the ImageFile object.

New Creates a new blank ImageFile object. Not available when the

application is running as an embedded server.
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ImageFile Object Methods (cont.)

Method Description
Ocr OCRs opened Image File.
Open Opens the ImageFile object. Not available when the application is
running as an embedded server.
Pages Returns a Page or PageRange object for the ImageFile object.
Print Prints the ImageFile object.
RotateAll Rotates all ImageFile object pages.
Save Saves changes to the ImageFile object.
SaveAs Saves the ImageFile object under another name.
SaveCopyAs Saves a copy of the ImageFile object. The application must be

running as an embedded server.

Update Updates the ImageFile object embedded within the container
application with the current data from the server application.
The application must be running as an embedded server.

AppendExistingPages Method

Description Appends specified page(s) to the end of the current ImageFile object. If the page(s) being
appended come from an image file of a type different than the active image file, the pages
are converted before being appended. After appending page(s), all PageRange objects are
invalid. You can optionally display a dialog box that allows the end-user to select a file from
which to append page(s).

Usage I mageFi | eQhj ect . AppendExi stingPages [ | mageFil e], [ Page],
[ Count], [Di spl ayUl Fl ag]

Arguments The AppendExistingPages method has the following parameters:

Parameter Data Type Description

ImageFile String The image file from which pages will be appended (source
image file).

Page Long The page from which to start appending pages (in the
source image file).

Count Long The number of pages to append.

DisplayUlIFlag Flag True — Displays a dialog box that allows the end-user to

select an image file to append.

False (Default) — Does not display a dialog box.

If you specify True and the selected file is a multi-page file,
the user is prompted to select the pages to append.
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Example ' Thi s exanpl e appends the first page fromthe file, BWTIF.
I mg. AppendExi stingPages "c:\bw. tif", 1

' This exanpl e appends a file selected froma dialog box to the
"currently displayed image file. After the user selects a file
'to append, the application pronpts the user to specify the
'starting page nunber and the nunber of pages to append from
"the selected file.

I mgl. AppendExi stingPages "", 0, 0, True

' Thi s exanpl e appends pages to an Inaging Server 1.x file.
I ngFi | eCbj . AppendExi sti ngPages
O "lmage://ngall\ SYS:\tmp\ 3PAGES. tif", 1, 3

' Thi s exanpl e appends pages to an |nmagi ng Server 1.x docunent.
I ngFi | eObj . AppendExi st i ngPages
O "Inage://PATRI OTS\ CABI NET\ DRAVER\ FOLDER\ doc1", 3, 2

' Thi s exanpl e appends pages to a WMS | magi ng Server
' docunent .
I mgFi | eQbj . AppendExi stingPages "I nmagex://sixpage", 1, 6

Close Method

Description Closes the ImageFile object. Closing an ImageFile object deletes it; all Page and PageRange
objects associated with it are also deleted. The Application object no longer has an
ImageFile object associated with it.

Usage I mageFi | eQbj ect. G ose [ SaveChangeFl ag]
Data Type Integer (Boolean).

Remarks The Close method SaveChangeFlag argument has the following settings:

Setting Description

True Changes are saved when the image file closes.

False (Default) Changes are not saved when the image file closes.

CreateContactSheet Method

Description Saves a contact sheet rendition of the ImageFile object. This method is unavailable when
the Application is running as an embedded server.

Usage I mageFi | e(oj ect . Creat eCont act Sheet (I nageFil e,
[I'ncl udeAnnot ati ons], [ OpenAfterSave])

Data Type String.
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Arguments The CreateContactSheet method has the following parameters:

Parameter Data Type Description

ImageFile String The image file object.

IncludeAnnotations  Integer Option to include annotations on the image stamps.
OpenAfterSave Integer Option to open the contact sheet file after it has

been created.

FindOIServerDoc Method

Description Finds 1.x documents or WMS Imaging documents. This method displays an Imaging
server document Find dialog box, from which the user may search for 1.x documents or
WMS Imaging documents. After the user selects a document and chooses the Open
button, the Find dialog box is closed and returns the selected document name, with a path,
to the user. A null string is returned if the user chooses Cancel in the Find dialog box. The
user may use the returned document name string as input for the Image Object Open
method.

Data Type String.
Usage I mageFi | eQbj ect . Fi ndO Ser ver Doc

Help Method
Description Displays the Imaging online Help table of contents.

Usage I mageFi | eObj ect. Hel p

InsertExistingPages Method
Description Inserts page(s) into the ImageFile object.

Page(s) to be inserted must come from an existing file. If the pages being inserted come
from an image file of a type different than the active image file, the pages are converted
before being inserted. After inserting page(s), all PageRange objects are invalid. You can
optionally cause a dialog box to open for the end-user to select a file from which to insert

page(s).
Usage I mageFi | eObj ect . I nsert Exi stingPages (I nageFile, |mgePage,
Count, Page, DisplayUl Fl ag)

Arguments The InsertExistingPages method has the following parameters:

Parameter Data Type Description

ImageFile String The image file from which page(s) are to be inserted (the
source image file).

ImagePage Long The page before which the new page(s) are to be inserted.
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Parameter Data Type Description

Count Long The number of pages to insert.

Page Long The page in the source image file from which to start
inserting pages.

DisplayUlIFlag Flag True — Displays a dialog box that allows the end-user to
select a source image file.
False (Default) — Does not display a dialog box.
If you specify True and the selected file is a multi-page file,
the user will be prompted to select the pages to append.

Example "This exanple inserts pages 4 and 5 fromthe file BWTIF
' before page 1.
I mg. I nsert Exi stingPages "c:\bw. tif", 1, 2, 4

"This exanple inserts page(s) into the current file at the
‘current page. (A dialog box pronpts the user for the inmage
"file to be selected for insertion. Another dial og box
"pronmpts for a page range.) Page, count, and pagenumnber
"argunents are required but ignored when dialogflag is True.
I mg. I nsert Exi stingPages "", 1, 1, 2, True
'This exanple inserts pages in an I maging Server 1.x file.
O I'nmgFil eCbj. I nsertExi stingPages
"I mage:// ngall\ SYS:\ t mp\ 3PAGES. tif", 2, 3, 1

"This exanpl e inserts pages in an |maging Server 1.x document.
I mgFi | eCbj . | nsert Exi sti ngPages
O0"1 mage: / / PATRI OTS\ CABI NET\ DRAVER\ FOLDER\ doc1", 2, 3, 1

" This exanpl e inserts pages in an WVS | nagi ng Server docunent.
I mgFi | eObj . I nsert Exi stingPages "I nagex://sixpage", 1, 2, 5

New Method

Description Displays a dialog box that allows the end-user to create a new ImageFile object that
contains one blank page.

Note: This method is not available when application is running as an embedded server.

Creating a new ImageFile object causes the new object to become active. If the active
ImageFile object is unsaved, the end-user is prompted to save it before the new object is
created.

No image file is associated with the object until you save it. The file type of the new object
is the same as the file type of the active object.

Usage I mageFi | eCbj ect. New ([ Di spl ayUl Fl ag] )
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Remarks The New method has the following parameter:

Parameter Data Type Description

DisplayUIFlag Flag True — Displays a dialog box that allows the end-user
to create a new image file.
False (Default) — Does not display a dialog box.

Example ' Thi s exanpl e creates a new i mage obj ect.
'Create the inage object
Dim App, Ing As Object
Set App = Createbject ("I nagi ng. Application")
Set I ng = App. Creat el nageVi ewer Obj ect (1)
"Call the image object New Met hod
I mg. New

Ocr Method
Description OCRs all image file pages.
Usage I mgeFi | e(oj ect. Ccr

Remarks The Image file must be open. The Ocr method uses the OcrOutputFile and
OcrOutputFileType properties.

Example 'This exanpl e perfornms an OCR on an i mage object.
Dim App, Img As Object
Set App = CreateObject ("I naging. Application")
Set I mg = App. Creat el nageVi ewer Obj ect (1)

I mg. Open "d:\pcx.tif"
I mg. Cecr

Open Method

Description Opens an image file in the parent application window. This associates an image file with the
ImageFile object. If a file is currently open, it should be closed before a new file is opened.
(See the Close Method).

Note: This method is unavailable when the application is running as an embedded server.

The Imaging application has the focus after an Open. You can reset the focus
programmatically after an Open, if desired.

Usage I mageFi | e(bj ect. Open( | nageFil e, [ I ncl udeAnnot ati on], [ Page] ,
[ Di spl ayUl Fl ag])
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Remarks The Open method has the following parameters:

Parameter Data Type Description

ImageFile String Name string of the ImageFile object to open.

IncludeAnnotation Flag True (Default)— The image has annotations that are
displayed.
False — The image has annotations that are not
displayed.

Page Long Page number in the image file to display. This parame-

ter must be a constant, or use the ActivePage property
to specify the page that you want displayed when you
open the file.

DisplayUIFlag Flag True — Displays a dialog box that allows the end-user
to select a file to open.
False (Default) — Does not display a dialog box.

Example ' Thi s exanpl e opens an inmage file nanmed 5page.tif:
I mg. Open "C:\inages\5page. tif"

' This exanpl e opens the same file to page 4 with annotations
' di spl ayed:
I mg. Open "C:\inmages\5page.tif", TRUE, 4

' Thi s exanpl e opens a di al og box so the user can select a
‘file to open:
I mg. Cpen "",,, TRUE

' Thi s exanpl e opens an Inmaging Server 1.x file.
I mg. Open "I nmage://ngall\ SYS:\tmp\ 3PAGES. tif", TRUE, 1

" This exanpl e opens an | magi ng Server 1.x docunent.
I mg. Open "I nage:// PATRI OTS\ CABI NET\ DRAVWER\ FOLDER\ doc1"

' Thi s exanpl e opens an WVS | nagi ng docunent .
I mg. Open" | nagex: // si xpage"

See Also ApplicationObject.Edit.

Pages Method

Description Returns the Page or PageRange object for the ImageFile object.
Usage I mgeFi | e(oj ect . Pages( St art Page, EndPage)

Data Type Long.

Remarks If you specify one page number, this method returns a Page object. If you specify two page
numbers, this method returns a PageRange object. To return a range of pages, specify the
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starting page number and ending page number. The first page number can be a variable,
but the second page number must be a constant.

The Pages method uses these parameters:

Parameter Data Type Description

StartPage Long The starting page of the page range to be returned.
EndPage Long The ending page of the page range to be returned.
Example ' Thi s exanpl e returns a Page object and a PageRange object.

Di m Page As bj ect

Di m PageRange As (bj ect

Set Page = |ng. Pages(1)

Set PageRange = | ng. Pages(1, 3)

Print Method

Description Prints the image file associated with the ImageFile object. You can optionally display a
dialog box to allow the end-user to select the print options.

Usage I mageFi | eQbject.Print ([DisplayU Flag])
Remarks The Print method DisplayUIFlag argument has the following settings:

Setting Description

True Displays a dialog box that allows the end-user to select print file options.
False (Default) No dialog box is displayed.
Example "This exanple prints the specified i mage file.

X = Ing. Print

RotateAll Method

Description Rotates all ImageFile object pages. Pages are rotated clockwise in 90 degree increments.

Usage I mageFi | e(hj ect. Rot at eAl |
Example 'This exanple rotates all pages of the currently displayed inage.
I mg. Rot at eAl |

Save Method

Description Saves changes to the ImageFile object. If no image file is associated with the ImageFile
object, the SaveAs method is executed instead of the Save method.

Usage I mageFi | e(bj ect. Save
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SaveAs Method

Description Saves the ImageFile object as another ImageFile object. Copies its image file and renames it.

This method allows you to specify the new object's image parameters. If specified, the file
can be converted from one type to another. The current image file is closed without being
saved and the Save As object becomes the active image file. You can optionally display a
dialog box that allows the end-user to name the file for the first time or select a file to
overwrite.

Usage I mageFi | e(hj ect. SaveAs (I mageFile, [FileType], [Di splayU Fl ag])
Data Type String.

Remarks The SaveAs method has the following parameters:

Parameter Data Type Description
ImageFile String The destination’s ImageFile object name string.
FileType Short The file type that you want to save the image as. This

number must be a constant. It must be present in the
command if the dialog flag option is used, even though its
value is ignored when the DisplayUTIFlag is set to True.

DisplayUlFlag  Flag True — Displays a dialog box that allows the end-user to
enter or select a filename and options for saving the file.
False (Default) — Does not display a dialog box.

The SaveAs method FileType argument settings are:

Setting Description
TIFF
Not supported
BMP
Example ' This exanple saves a file in TIF format.
I mg. SaveAs "picturel. tif", 1

' Thi s exanpl e opens a Save As di al og box so that the end-user can
"name the file for the first time or overwite an existing file:
I mg. SaveAs "", 0, True
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SaveCopyAs Method

Description Saves a copy of the ImageFile object as another ImageFile object. You may specify the
FileType of the destination file. The FileType can be TIFF or BMP.

This method allows you to specify the new object’s image parameters. If specified, the file
can be converted from one type to another. The current image file remains the active image
file. This method can only be used after launching the embedded server application in a
separate window.

Usage I mageFi | e(oj ect. SaveCopyAs (I nmageFile, FileType, D splayU Flag)
Data Type String.

Remarks  The SaveCopyAs method has the following parameters:

Parameter Data Type Description
ImageFile String The destination’s ImageFile object name string.
FileType Short The image file type that you want to save the image as.

This number must be a constant. It must be present in the
command if the dialog flag option is used, even though its
value is ignored when the DisplayUIFlag is set to True.

DisplayUlFlag  Flag True — Displays a dialog box that allows the end-user to
enter or select a filename and options for saving the file.
False (Default) — Does not display a dialog box.

Update Method

Description Updates the ImageFile object embedded within the container application with the current
data from the server application.

This method can only be used after launching the embedded server application in a separate
window.

Usage I mageFi | e(oj ect . Updat e
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Page Object

A Page object represents a single page in an ImageFile object. Page objects can only be

accessed by using the Pages method of the parent ImageFile object.

Page Object Properties

The following table lists the Page object properties.

Page Object Properties

Property Description
Application Returns the Application object.
CompressionInfo Returns the page’s compression information.
CompressionType Returns the page’s compression type.

Height Returns the page’s height.

ImageResolutionX Sets or returns the page’s horizontal resolution.
ImageResolutionY Sets or the returns page’s vertical resolution.
Name Returns the page number of this page.

PageType Returns the page’s image type.

Parent Returns the parent of the Page object.
ScrollPositionX Sets or returns this page’s horizontal scroll position.
ScrollPositionY Sets or returns this page’s vertical scroll position.
Width Returns the page’s width.

Application Property

Description Returns the Application object. This is a read-only property.

Usage PageObj ect . Appl i cation
Data Type Object.
Example ' This exanpl e returns the Application object.

Compressioninfo Property

Dimlnmg As ObjectDimParent As Object Set

Parent =

O 1 ng. Pages(1). Application

Description Returns this page’s compression information. This is a read-only property.

Usage
Data Type

PageObj ect . Conpr essi onl nf 0]

Long.
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Remarks The CompressionInfo property settings are:

Setting Description
0 No compression options set. Only applicable to uncompressed image files.
1 EOL (Include/expect End Of Line). Each line is terminated with an end-of-

line bit. Not used for JPEG compression.

Packed Lines (Byte align new lines). Not used for JPEG compression.

Prefixed EOL (Include/expect prefixed End Of Line). Each strip of data is pre-
fixed by a standard end-of-line bit sequence. Not used for JPEG compression.

8 Compressed LTR (Compressed bit order, left to right). The bit order for the
compressed data is the most significant bit to the least significant bit. Not used
for JPEG compression.

16 Expanded LTR (Expanded bit order, left to right). The bit order for the
expanded data is the most significant bit to the least significant bit. Not used for
JPEG compression.

32 Negate (Invert black and white on expansion). Indicates the setting of the Pho-
tometric Interpretation field of a TIFF file. Not used for JPEG compression.

64 Low Resolution/High Quality JPEG compression only).

128 Low Resolution/Medium Quality (JPEG compression only).

256 Low Resolution/Low Quality (JPEG compression only).

512 Medium Resolution/High Quality (JPEG compression only).

1024 Medium Resolution/Medium Quality (JPEG compression only).
2048 Medium Resolution/Low Quality (JPEG compression only).
4098 High Resolution/High Quality (JPEG compression only).

8196 High Resolution/Medium Quality (JPEG compression only).
16392  High Resolution/Low Quality (JPEG compression only).

Remarks Image files that do not have a compression type of JPEG will have a value between 1 and
63. This value is a combination of the values of 1 to 32. For JPEG files, the value is from 64
to 16384, and is only one of these values.

Example 'This exanpl e returns the page's conpression information.
x = I mg. Pages(1). Conpressionlnfo

CompressionType Property
Description Returns this page’s compression type. This is a read-only property.

Usage Pagenj ect . Conpr essi onType[ =val ue]
Data Type Short.
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Remarks

Example

The CompressionType property settings are:

Setting Description

Unknown

No Compression

Group 3 1D FAX

Group 3 Modified Huffman
PackBits

Group 4 2D FAX

JPEG

Reserved

Group 3 2D FAX

LZW

O X NN N U N, O

' This exanpl e returns this page's conpression type.
x = | ny. Pages(1). Conpressi onType

Height Property

Description Returns this page’s height in pixels. This is a read-only property.

Usage
Data Type

Example

Pagebj ect . Hei ght
Long.

' This exanpl e returns this page's height in pixels.
x = I ng. Pages(1) . Hei ght

ImageResolutionX Property

Description Sets or returns this page’s horizontal resolution, in dots-per-inch. An error occurs when a

Usage
Data Type

Example

value less than 20 or greater than 1200 dpi is specified. This is a read/write property.
Pagebj ect . | mageResol uti onX [ = val ue]
Long.

' This exanpl e sets this page's horizontal resolution.
I mg. Pages(1). | mageResol uti onX = 200

'This exanple returns this page's horizontal resol ution.
XRes = | ng. Pages(1).|mgeResol uti onX
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ImageResolutionY Property

Description Sets or returns this page’s vertical resolution, in dots-per-inch. An error occurs when a
value less than 20 or greater than 1200 dpi is specified. This is a read/write property.

Usage Pagebj ect . | mageResol uti onY [ = val ue]
Data Type Long.

Example "This exanpl e sets this page's vertical resolution.
I ng. Pages(1). | mageResol utionY = 200

'This exanple returns this page's vertical resolution.
YRes = | ng. Pages(1).|mgeResol uti onY

Name Property

Description Returns the page number of the page in the ImageFile object. This is a read-only property.
Usage PageObj ect . Nane

Data Type Long.

Example ' Thi s exanpl e returns the page nunber of the page in the
"I mageFi | e obj ect.
x = I ng. Pages(1). Nane

PageType Property

Description Returns the page’s image type. This is a read-only property.
Usage PageQbj ect . PageType

Data Type Short.

Remarks The PageType property settings are:

Setting Description

Black and White
Gray 4

Gray 8
Palettized 4
Palettized 8
RGB 24

N U1 B~ N -

Example ' This exanpl e returns the page's image type.
x = | ny. Pages(1). PageType
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Parent Property

Description Returns the parent of the Page object. This is a read-only property.
Usage Pagebj ect . Par ent

Data Type Object.

Example 'This exanpl e returns the parent of the Page object.
X = I ng. Pages(1). Parent

ScrollPositionX Property

Description Sets or returns this page’s horizontal scroll position, in pixels. This is a read/write property.
Usage PageObj ect . Scrol | Posi ti onX [=val ue]

Data Type Long.

Example 'This exanpl e sets this page's horizontal scroll position.
I mg. Pages(1). Scrol |l PositionX = 200

'This exanple returns this page's horizontal scroll position.
xpos = | ng. Pages(1).Scroll PositionX

ScrollPositionY Property

Description Sets or returns this page’s vertical scroll position, in pixels. This is a read/write property.
Usage Pagebj ect. Scrol | Posi tionY [=val ue]

Data Type Long.

Example 'This exanpl e sets this page's vertical scroll position.
I mg. Pages(1). Scrol | PositionY = 200

' This exanple returns this page's vertical scroll position.
ypos = I ny. Pages(1). Scroll PositionY

Width Property

Description Returns this page’s width, in pixels. This is a read-only property.
Usage PageObj ect. Wdt h

Data Type Long.

Example "This exanple returns this page's width in pixels.
x = I ng. Pages(1).Wdth
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Page Object Methods

The following table lists the Page object methods.
Page Object Methods

Method Description
Delete Deletes the page.
Flip Rotates the page 180 degrees.
Help Displays online Help.
Ocr OCRs Image Page.
Print Prints the page.
RotateLeft Rotates the page counterclockwise 90 degrees.
RotateRight Rotates the page clockwise 90 degrees.
Scroll Scrolls the page.

Delete Method

Description Deletes the specified page from the active object. After deleting a page, the next page is
displayed (if one exists). Otherwise, the previous page is displayed.

Usage PageObj ect . Del et e

Example ' Thi s exanpl e del etes the specified page.
I mg. Pages(1).Del ete

Flip Method

Description Rotates the specified page 180 degrees. This change becomes permanent when the image
file is saved.

Usage PageObj ect. Flip
Example "This exanple flips the page.
I ng. Pages(1).Flip

Help Method

Description Displays the Imaging online Help table of contents.

Usage Pagenj ect . Hel p

Ocr Method
Description OCRs the image page.
Usage PageObj ect . Ccr
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Print Method
Description Prints the page.
Usage PageObj ect . Pri nt

Example 'This exanple prints the page.
X = Ing. Pages(1).Print

RotateLeft Method

Description Rotates the page 90 degrees counterclockwise. This change becomes permanent when the
image file is saved.

Usage PageObj ect . Rot at eLeft

Example 'This exanple rotates the page 90 degrees to the left.
I mg. Pages(1). Rot ateLeft

RotateRight Method

Description Rotates the page 90 degrees clockwise. This change becomes permanent when the image
file is saved.

Usage Pagehj ect . Rot at eRi ght

Example '"This exanpl e rotates the page 90 degrees to the right.
I mg. Pages(1). Rot at eRi ght

Scroll Method
Description Scrolls the page.

Usage PageObj ect. Scrol | Direction, Scrol | Arount

Remarks The Scroll method uses the following parameters:

Parameter Data Type Description

Direction Integer Direction in which to scroll the image:
0 — (Default) Scrolls down
1 — Scrolls up
2 — Scrolls right
3 — Scrolls Left

ScrollAmount  Long Number of pixels to scroll the image

Example 'This exanple scrolls the page down 200 pi xel s.
I mg. Pages(1).Scroll 0 200
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PageRange Object

A PageRange object represents a range of consecutive pages in an ImageFile object. A page
range is a set of pages starting at the StartPage property and ending at the EndPage
property. PageRange objects can only be accessed by using the Pages method of the parent
ImageFile object.

PageRange Object Properties
The following table lists the PageRange object properties.
PageRange Object Properties

Property Description
Application Returns the Application object.
Count Returns the number of pages in this range.
EndPage Returns or sets the page number of the last page in the range.
Parent Returns the parent of the PageRange object.
StartPage Returns or sets the page number of the first page in the range.

Application Property

Description Returns the Application object. This is a read-only property.
Usage PageRangeQnj ect . Appl i cation

Description Object.

Count Property

Description Returns the number of pages in this range. This is a read-only property.
Usage PageRangenj ect . Count

Data Type Long.

EndPage Property
Description Returns or sets the page number of the last page in the range. This is a read/write property.

Usage PageRange(bj ect . EndPage [ =val ue]
Data Type Long.

Remarks  This property setting is the number of the last page. The value of EndPage must be greater
than or equal to the value of StartPage.
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Parent Property

Description
Usage
Data Type

Example

Returns the parent of the PageRange object. This is a read-only property.
PageRangebj ect . Par ent
Object.

'This exanpl e returns the parent of the PageRange object.
X = I ng. Pages(1, 7). Parent

StartPage Property

Description

Usage
Data Type

Remarks

Returns or sets the page number of the first page in the range. This is a read/write
property.

PageRange(hj ect . St art Page [ =val ue]

Long.

This property setting is the number of the first page. The value of StartPage must be less
than or equal to the value of EndPage.

PageRange Object Methods

The following table lists the PageRange object methods.
PageRange Object Methods

Method Description
Delete Deletes the page range.
Ocr OCRs the page range.
Print Prints the page range.

The Delete, Ocr, and Print methods of the PageRange object use the following
parameters:

Parameter Data Type Description
StartPage Long First page to be deleted.
NumPages Long Number of pages to be deleted, including the StartPage.

Delete Method

Description

Usage

Example

Removes pages from the ImageFile object. After deleting a PageRange object, all page
ranges are invalid.

PageRangehj ect . Del et e( )

' Thi s exanpl e del etes the pages 1 through 3.
I mg. Pages(1, 3).Delete
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Ocr Method

Description OCRs the page range.

Usage PageRange(bj ect . Ccr ()

Example ' Thi s exanpl e OCRs pages 2 through 6.
X = I nmg. Pages(2, 6). Ccr

Print Method

Description Prints the page range.
Usage PageRange(hj ect. Print( )

Example ' This exanple prints pages 1 through 5.
x = I ng. Pages(1,5). Print
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Adding Imaging Using ActiveX Controls

This chapter demonstrates how to use the Imaging ActiveX controls to
image-enable your applications.

It begins by explaining how to load the Imaging ActiveX controls into
your development environment. Then it explains how to access the
on-line help for the controls. It concludes by walking you through some
sample applications to help you get started.

In This Chapter

Loading the CoNntrols .......ccccooviiiiiii e 80
ObtainiNng Help ..o 84
Demonstration ProjectS.........ooiviiiiiiiiiie e 90
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Loading the Controls

This section explains how to Before you can use the Imaging ActiveX controls, you must load them

load the Imaging ActiveX into your development environment.
controls into three devel-

opment environments: Loading the controls consists of the following basic
Microsoft Visual Basic, tasks:

Visual C++, and Access.

* Selecting each Imaging ActiveX control from a list of registered
ActiveX controls on your system.

Inserting each Imaging ActiveX control icon into the controls
toolbox of your development environment.

The following list shows how the Imaging ActiveX controls appear
on your system:

— Image Admin Control

— Image Edit Control

— Image OCR Control

— Image Scan Control

— Image Thumbnail Control

— Image Server Access Object
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The following table lists the icons that represent each Imaging ActiveX
control in the controls toolbox of your development environment.

Imaging ActiveX Toolbox Icons

Icon Name Notes

Image Admin Available with all versions
of Imaging.

Image Annotation A member of the Image
W Tool Button Edit control.

Image Edit Available with all versions
& of Imaging.

Image OCR Available with some
versions of Imaging.

Image Scan Available with all versions
= of Imaging.

Image Thumbnail Available with all versions
pan of Imaging.
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Visual Basic

(0

A control is selected when a

check mark appears next to it.

Visual C++

82

To add the Imaging ActiveX controls to Visual Basic
1 Start Visual Basic and create a new project.

2 On the Project menu, click Components.
3 On the Components dialog box, click the Controls tab.

4 Select the Imaging ActiveX controls from the controls listed. (Refer
to “Loading the Controls” earlier in this chapter to see a list of
Imaging ActiveX controls.)

5 Click OK. Visual Basic adds the controls to your project and the
control icons to your toolbox.

6 Work with the Imaging ActiveX controls as you would any other
type of ActiveX control.

To add the Imaging ActiveX controls to Visual C++
1 Start Visual C++ and create a new project.

2 On the Project menu, point to Add to Project, and click
Components and Controls. The Component and Controls
Gallery dialog box appears.

3 In the Look In list box, click SharedIDE and then Gallery.

4 Below the Look In list box, double-click Registered ActiveX
Controls. A list of registered ActiveX controls appears.

5 For each Imaging ActiveX control:

a Click the desired control among the list of registered controls and
then click Insert. (Refer to “Loading the Controls” earlier in this
chapter to see a list of Imaging ActiveX controls.)

b On the Confirm Classes dialog box, click OK. Visual C++ adds
the control to your project and its icon to the Controls toolbox,
which is visible when you edit a dialog box in Resource View.

6 When you have finished adding the Imaging ActiveX controls, click
Close on the Components and Controls Gallery dialog box.

7 Work with the Imaging ActiveX controls as you would any other
type of ActiveX control.

Note: |If you are using Microsoft Foundation Classes (MFC), be sure to
call AfxEnableControlContainer within | ni t | nst ance.
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Access

(0 o

If you selected the OLE
Controls check box in the
Setup program when you
installed Microsoft Access, the
Imaging ActiveX controls are
available automatically.

To add the Imaging ActiveX controls to Access
1 Start Access and create a new database.

2 On the Tools menu, click ActiveX Controls.

3 If the ActiveX Controls dialog box lists all of the Imaging ActiveX
controls as available, click Close and proceed to Step 4.

For each control the dialog box does nof list as available:
a Click Register.

b On the Add ActiveX Control dialog box, navigate to your
| magi ng folder.

c Click the file name of the control not listed as available. Then
click Open to register the control.

The following table lists the file names of each Imaging ActiveX

control.
Imaging ActiveX Control File Names
Click This File To Register This Control
imgadmin.ocx Image Admin
imgedit.ocx Image Annotation Tool Button
imgedit.ocx Image Edit
1IMgocr.ocx Image OCR
imgscan.ocx Image Scan
imgthumb.ocx Image Thumbnail

d When you finish registering the controls, click Close to exit the
ActiveX Controls dialog box.

4 Enter Form or Report design view.
5 On the View menu:

a If necessary, click Toolbox to display the Controls toolbox.
b Point to Toolbars and click Customize.

6 On the Customize dialog box, click the Commands tab.
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Obtaining Help
This section explains how to
access the on-line help

system of the Imaging
ActiveX controls.

Visual Basic

84

7 In the Categories list box:
a Click ActiveX Controls.

b From the Commands list box, drag each Imaging ActiveX
control and drop it onto the Controls toolbox.

¢ When you finish dragging and dropping the Imaging ActiveX
controls onto the toolbox, click Close.

8 Work with the Imaging ActiveX controls as you would any other
type of ActiveX control.

How you access the Imaging ActiveX Controls on-line help system
differs within each of the following programming environments:

*  Visual Basic
*  Visual C++
= Access

The following sections describe how to access help in each environment.

Note: Several methods in the Imaging ActiveX controls present dialog
boxes to the end user. Each dialog box provides its own context-
sensitive help, which the user can invoke by clicking the ques-
tion mark at the top of the dialog box and then the desired
control.

There are many ways to access the Imaging ActiveX Controls on-line
help in Visual Basic. You can access help from the:

* Object Browser

* Toolbox

*  Form window

* Properties window
* Code window

Before attempting to access help, make sure that the Imaging ActiveX
controls have been added to your current project. (Refer to “Loading the
Controls” for instructions.)
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Object Browser
To access Imaging ActiveX help from the Object Browser

1 On the View menu, click Object Browser. The Object Browser
appears.

2 In the Project/Library list box, click the library name of the desired
Imaging ActiveX control.

The following table lists the library and class names of each Imaging
ActiveX control.

Imaging ActiveX Control Library and Class Names

Library Name Class Name Imaging Control
AdminLibCtl ImgAdmin Image Admin
ImgeditLibCtl ImgAnnTool Image Annotation Tool

Button
ImgeditLibCtl ImgEdit Image Edit
IMGOCRLib Imgocr Image OCR
ScanLibCtl ImgScan Image Scan
ThumbnailLibCtl ImgThumbnail Image Thumbnail

3 In the Classes list box, click the class name of the control. (Refer to
the preceding table for a list of class names.)

4 In the Members list box, click the desired property, method, or
event, and then press F1. The help topic for the selected member
appears.

Note: If the member you select is an extender property, method, or
event, Visual Basic’s on-line help appears.

Toolbox
To access Imaging ActiveX help from the Toolbox

* Click the desired Imaging ActiveX control in the toolbox, and then
press F1. The overview topic for the selected control appears.

From the overview topic, you can navigate to other topics that
describe the properties, methods, and events of the selected control.
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Form Window

To access Imaging ActiveX help from the Form window
1 Draw at least one Imaging ActiveX control on a form.

2 Select the Imaging ActiveX control on the form.

3 Press F1. The overview topic for the selected control appears.

From the overview topic, you can navigate to other topics that
describe the properties, methods, and events of the selected control.

Properties Window
To access Imaging ActiveX help from the Properties window
1 Select an Imaging ActiveX control that has been drawn on a form.

Then, on the View menu, click Properties Window. The
Properties window appears.

2 Click the desired property in the Properties window and then press
F1. The help topic for the selected property appears.

Note: Keep in mind that only the design-time properties appear in the
Properties window.
If the property you select is an extender property, Visual Basic’s
on-line help appears.

Code Window

To access Imaging ActiveX help from the Code window

1 Make sure that at least one Imaging ActiveX control has been drawn
on a form.
2 Invoke the Code window.

3 Within your code, select the Imaging property, method, or event for
which you want help. Then press F1. The help topic for the selected

property, method, or event appears I.

Note: |[f the property, method, or event you select is an extender
property, method, or event, Visual Basic’s on-line help appears.

86



Adding Imaging Using ActiveX Controls |

Visual C++

There are two ways to access the Imaging ActiveX Controls on-line help
in Visual C++. You can access help from the:

* Components and Controls Gallery dialog box

* Properties window

Before attempting to access help, make sure that the Imaging ActiveX
controls have been added to your current project. (Refer to “Loading the
Controls” for instructions.)

Components and Controls Gallery Dialog Box

Properties Window

To access Imaging ActiveX help from the Components and
Controls Gallery dialog box

1 On the Project menu, point to Add To Project and click
Components and Controls. The Components and Controls
Gallery dialog box appears.

2 Click the desired Imaging ActiveX control below the Lookin box,
and then click More Info. The overview topic for the selected
control appears.

From the overview topic, you can navigate to other topics that describe
the properties, methods, and events of the selected control.

To access Imaging ActiveX help from the Properties window
1 Select an Imaging ActiveX control that has been drawn on a form.
2 On the View menu, click Properties.
3 Click the desired property in the Properties window, and then press

F1. The help topic for the selected property appears.

Note: Keep in mind that only the design-time properties appear in the
Properties window.
If the property you select is an extender property, the contents

window for the Imaging ActiveX help system appears.
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Access

Object Browser

Properties Window

88

There are three ways to access the Imaging ActiveX Controls on-line
help in Access. You can access help from the:

* Object Browser

* Properties window

* Module window

Before attempting to access help, make sure that the Imaging ActiveX
controls have been added to your current database. (Refer to “Loading
the Controls” for instructions.)

To access Imaging ActiveX help from the Object Browser
1 Make sure the Module window is currently on display.

2 On the View menu, click Object Browser. The Object Browser
appears.

3 In the Project/Library list box, select the library of the desired
Imaging ActiveX control. (Refer to “Visual Basic” earlier in this
section to see a list of library and class names for each Imaging
ActiveX control.)

4 In the Classes list box, click the class name of the desired control.
(Refer to the aforementioned list.)

5 In the Members list box, click the desired property, method, or
event, and then press F1. The help topic for the selected member
appears.

Note: |If the member you select is an extender property, method, or
event, Visual Basic's on-line help appears — provided Visual
Basic is installed on your system. Access does not provide help
for extender properties, methods, or events in the Object
Browser.

To access Imaging ActiveX help from the Properties window
1 Select an Imaging ActiveX control that has been drawn on a form.

2 On the View menu, click Properties.

3 On the Properties window, click the Other tab or the All tab.
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4 Click the desired property in the Properties window and then press
F1. The help topic for the selected property appears.

Note: Keep in mind that only the design-time properties appear in the
Properties window.
If the property you select is an extender property, Access’ on-line
help appears.

Module Window

To access Imaging ActiveX help from the Module window

1 Make sure that at least one Imaging ActiveX control has been drawn
on a form.
2 Invoke the Module window.

3 Select the Imaging property, method, or event within your code for
which you want help. And then press F1. The help topic for the
selected property, method, or event appears 1.

Note: |If the property, method, or event you select is an extender
property, method, or event, Visual Basic’s on-line help appears
— provided Visual Basic is installed on your system.
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Demonstration Projects

This section demonstrates To help you use the Imaging ActiveX controls, seven demonstration

how to add a variety of projects show you how to:
Imaging functions to your

applications. * Display an image and apply fit-to options.
A wide-ranging discussion of " Convert an image.
every Imaging function is * Copy an image.
beyond the scope of this
chapter; however it does
discuss many of the popular * Scan images using a template.
ones.

* Print an image.

* Manage an image file using thumbnails.

All demonstration projects * Unload a multipage image file.
were developed using

Microsoft Visual Basic. Note: The ActiveX Controls on-line help system identifies the

properties, methods, events, parameters, and constants that are
available in each version of Imaging for Windows.

Displaying an Image and Applying Fit-To Options
The FitTo Options demonstration project shows how to display an image
at various fit-to settings. Before walking through the demonstration
project, read the following section, which explains the concept of fitting
an image and describes the various fit-to options.

Fit-To Options Defined
Fit-to options govern the way an Image Edit control displays images.

The FitTo method of the Image Edit control lets you select — usually in
response to user input — the scaling factor, or fit-to option, applied to
images when they're displayed.

Most image application developers make fit-to functions available to their
end users. These functions let users scale the image so it can be seen
more clearly, which is particularly important when users read scanned
documents or faxes.
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(0

You can provide your users
with even more control over a
displayed image by using the
Zoom property of the Image
Edit control in addition to the
FitTo method.

You can provide the following fit-to options to your end users:

Best Fit — Scales the image so it appears in the entire Image Edit
control. The full height or the full width of the image appears in the
control, depending on which results in the least unused space.

Fit To Width — Scales the image so it matches the width of the Image
Edit control.

Fit To Height — Scales the image so it matches the height of the Image
Edit control.

Inch To Inch — Scales image pages so images of the same dimensions
appear the same size on the monitor.

Pixel To Pixel — Scales image pages so image pixels map to screen
pixels. A 200 DPI image would appear twice as large as a 100 DPI image
even when these images have the same dimensions.

Example

Users of your application may want control over the display of image
documents to make them easy to read.

Scenario

Assume Eileen receives several scanned business documents in her role as
product manager for a major computer company. Because she receives
these documents from others via e-mail, she has no control over how
they are scanned, but she really needs to be able to read them.

Because you included all of Image Edit’s fit-to options in your
application, Eileen can select the one that produces the best display
quality— enabling her to view the image documents clearly and read
them easily.
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FitTo Options Project

The FitTo Options project demonstrates displaying an image at a variety
of fit-to options.

The file name for the FitTo
Options project is

Fi tTo. vbp.
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